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1 Introduccion

El presente documento describe cuales son las tareas basicas que se pueden ejecutar en la explotacién
de la herramienta de modelado Enterprise Architect Corporate Edition.

El contenido del documento integra, tanto los aspectos de uso en el entorno de EJIE como las
caracteristicas elementales de funcionamiento de la aplicacion.

2 Conceptos basicos

Enterprise Architect Corporate Edition es una herramienta CASE para el disefio y construccion de
sistemas software.

Enterprise Architect Corporate Edition soporta la especificacion UML 2.0, que describe un lenguaje visual
que permite la definicién de los modelos de un proyecto.

Se trata de una herramienta progresiva que cubre todos los aspectos del ciclo de un desarrollo,
proporcionando una completa trazabilidad desde la fase inicial de disefio hasta el desarrollo y posterior
mantenimiento. Asi mismo, también proporciona soporte para testing y control de cambios.

Enterprise Architect Corporate Edition, permite la realizacion de ingeniera directa e inversa, sincronizar
los elementos de los modelos con el cédigo fuente de las clases (ActionScript, C++, C#, Delphi, Java, Python,
PHP, VB.NET y Visual Basic), disefiar y generar elementos de base de datos y generar documentacion de gran
calidad facilmente exportable a formato RTF.

Enterprise Architect Corporate Edition soporta todos los modelos/diagramas de UML 2.0. Permite disefiar
desde procesos de negocio, sitios web, interfaces de usuario, configuraciones hardware, hasta estimar el
esfuerzo del proyecto en horas

El repositorio esta basado en DBMS proporciona buenos tiempos de respuesta cuando se trabaja con
varios usuarios debido a su estructura interna. Ademas, cualquier problema de conexién que se produzca,
deberia ser cubierto por las habilidades del servidor DBMS, permitiendo deshacer cualquier transaccion
interrumpida por problemas externos.

En nuestro caso se ha seleccionado SQL Server 7.0 como repositorio de proyectos, y la licencia
Corporate Edition.

Para obtener informacién adicional sobre el producto acceder a su pagina web:

http://www.sparxsystems.com.au/products/ea.html

21 UML

Lenguaje Unificado de Modelado (UML, por sus siglas en inglés, Unified Modeling Language) es el
lenguaje de modelado de sistemas de software mas conocido y utilizado en la actualidad; aun cuando todavia
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no es un estandar oficial, esta respaldado por el OMG (Object Management Group). Es un lenguaje grafico para
visualizar, especificar, construir y documentar un sistema de software. UML ofrece un estandar para describir un
"plano” del sistema (modelo), incluyendo aspectos conceptuales tales como procesos de negocios y funciones
del sistema, y aspectos concretos como expresiones de lenguajes de programacion, esquemas de bases de
datos y componentes de software reutilizables.

Es importante resaltar que UML es un "lenguaje" para especificar y no para describir métodos o procesos.
Se utiliza para definir un sistema de software, para detallar los artefactos en el sistema y para documentar y
construir. En otras palabras, es el lenguaje en el que esta descrito el modelo. Se puede aplicar en una gran
variedad de formas para dar soporte a una metodologia de desarrollo de software -pero no especifica en si
mismo qué metodologia o proceso usar.

UML cuenta con varios tipos de diagramas, los cuales muestran diferentes aspectos de las entidades
representadas.

£

Structure
Diagram Brehavior

? Diagram

Class Diagram CDDFPPDHEW De&'fgy::;m Activity Diagram State Machine
Sl Dizgran

Irteraction

- i = Use Caze
Object Diagrann Composite Package Diagram Diagramm Diagram
Structure Diagram

?

Sequence Comrnuni cation Irteraction Tirning Diagram
Diagram Diagram Ouverview

Diagrarm

Tal y como se puede ver en la imagen existen dos grandes grupos:

Diagramas de Estructura
Se trata de los diagramas que enfatizan los elementos que deben existir en el sistema modelado.

o Diagrama de clases: Describe la estructura de un sistema mostrando sus clases, atributos y las
relaciones entre ellos. Los diagramas de clases son utilizados durante el proceso de analisis y
disefio de los sistemas informaticos, donde se crea el disefio conceptual de la informacion que se
manejara en el sistema, y los componentes que se encargaran del funcionamiento y la relaciéon
entre uno y otro.

o Diagrama de componentes: Un diagrama de componentes representa la separacion de un
sistema de software en componentes fisicos (por ejemplo archivos, cabeceras, médulos,
paquetes, etc.) y muestra las dependencias entre estos componentes.

o Diagrama de objetos: Se puede considerar un caso especial de un diagrama de clases en el
que se muestran instancias especificas de clases (objetos) en un momento particular del sistema.
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Los diagramas de objetos utilizan un subconjunto de los elementos de un diagrama de clase. Los
diagramas de objetos no muestran la multiplicidad ni los roles, aunque su notacién es similar a los
diagramas de clase.

e Diagrama de estructura compuesta (UML 2.0): Se trata de un diagrama que permite
contextualizar las partes que componen a una clase, muestra la estructura interna de una clase,
incluyendo sus puntos de interaccion a otras partes del sistema.

o Diagrama de despliegue: Se utiliza para modelar el hardware utilizado en las implementaciones
de sistemas y las relaciones entre sus componentes.

o Diagrama de paquetes: Muestra como un sistema esta dividido en agrupaciones logicas
mostrando las dependencias entre esas agrupaciones. Dado que normalmente un paquete esta
pensado como un directorio, los diagramas de paquetes suministran una descomposicion de la
jerarquia légica de un sistema.

Diagramas de comportamiento
Se trata de los diagramas que enfatizan lo que debe suceder en el sistema modelado

e Diagrama de Actividades: representa los flujos de trabajo paso a paso de negocio y
operacionales de los componentes en un sistema. Un Diagrama de Actividades muestra el flujo
de control general.

e Diagrama de Casos de Uso: Un diagrama de casos de uso es una representacion gréafica de
parte o el total de los actores y casos de uso del sistema, incluyendo sus interacciones.

o Diagrama de Estados: Se trata de diagramas que se usan para representar graficamente
magquinas de estados finitos.

e Diagramas de Interaccion: Se trata de diagramas que enfatizan el flujo de control y de datos
entre los elementos del sistema modelado

o Diagrama de Secuencia: Muestra la interaccién de un conjunto de objetos en una
aplicacién a través del tiempo y se modela para cada caso de uso.

o Diagrama de Colaboracién:Un diagrama de colaboracién es una forma alternativa al
diagrama de secuencia de mostrar un escenario. Este tipo de diagrama muestra las
interacciones entre objetos organizadas entorno a los objetos y los enlaces entre ellos.

o Diagrama de Tiempos: Es una grafica de formas de onda digitales que muestra la
relacion temporal entre varias sefales, y como varia cada sefial en relacion a las demas.

o Diagrama de Vistas de Interaccion: Se rata de un diagrama que describe la
cooperacion entre distintos diagramas de interaccion, proporcionando un flujo de control
determinado.

Asi mismo, EA proporciona los siguientes diagramas extendidos:

o Diagramas de Analisis: Se trata de un diagrama de actividades simplificado, que se utiliza para
la definicién de procesos de negocio de alto nivel.

e Diagramas a Medida: Se trata de un diagrama de clases extendido utilizado para capturar
requerimientos, interfaces de usuario o modelos de disefio.

o Diagramas de Requerimientos: Diagrama que permite describir los requerimientos del sistema
y sus caracteristicas.

e Diagramas de Mantenimiento: Se trata de un diagrama utilizado para describir peticiones de
cambio dentro de un sistema.

e Diagramas de interfaz de usuario: Se trata de diagramas que permite el disefio de las pantallas
utilizando formularios, controles y etiquetas.

e Diagramas de base de datos: Se trata de un diagrama que permite definir las tablas y las
relaciones entre las mismas de una base de datos.
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3 Funciones elementales

Los pasos minimos que debe ejecutar el responsable del proyecto se pueden resumir como:

= Solicitar el repositorio del proyecto en BD

= Crear el proyecto

= Activar seguridad

= Establecer usuario(s) administrador(es)

= Crear grupos de usuarios y asignarles privilegios
= Crear usuarios y asignarlos a grupos

3.1 Crear el proyecto

Previamente (en fase 0) se habra solicitado al servicio de implantacion la creacién del repositorio en
SQLServer, facilitandonos los siguientes datos:

Nombre del servidor
Nombre de la base de datos
= Usuario

= Password

Importante: El proceso descrito a continuacién lo debera ejecutar el responsable del proyecto una sola
vez. Las sucesivas veces que se llevase a cabo supondria perder todos los modelos contenidos en el repositorio
remoto, es decir, seria equivalente a un proceso de reinicio del proyecto.

Que implantacién confirme la creacidn del repositorio no significa que ya se pueda empezar a trabajar,

tan solo se dispone del espacio necesario para gestionar el proyecto. Por tanto el primer paso a realizar por el
responsable es crear el proyecto, ejecutando el menu Tools—> Data Management->Data Transfer
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Project Transfer

Tranzter Type
() EAPto EAP () DEMS to EAP

Source and Target Projects

Source Project: | LIMLAE ntfegarauudahEHE

Target Project: | 1:

Logfile
Logfile | |

Caution: The Target Project will be erazed priar to transfer. Pleasze ensure vou have backed
g target if neceszan

Tramnzfer l [ LCloze ] [ Help ]

Frogress:

Se completa la pantalla:

= En el tipo de transferencia a realizar se marca la opcién .EAP to DBMS

= En el campo de Source Model se pincha el botén ... que aparece alineado permitiendo asi
buscar en nuestro disco un fichero EAP que se va a usar como modelo, el que se ha de instala
que contiene la estructura de EJIE es el fichero EJIE_BASICO.EAP

= Pinchando el botén “...” alineado con Target Model se seleccionara como destino la BD SQL
Server que nos han generado:
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B Data Link Properties

Pravider Eu:unneu:tiu:unl .-’-'-.dvanu:edl Al I

Select the data pou want to connect to:

EJie

OLE DB Providerz)

kediaCatalogDB OLE DB Provider
bediaCataloghergedDB OLE DE Provider
MediaCatalogiw/ebDE OLE DB Prowvider
Microzaoft Jet 4.0 OLE DB Prowvider

bicrozoft OLE DB Provider For Data Mining Services
bicrozoft OLE DB Provider for DTS Packages
bicrozaft OLE DB Provider for Indexing Service
Micrazaft OLE DB Pravider for Internet Publizhing
Microsaft OLE DB Provider for Microzoft Search
Microsoft OLE DB Provider for QDBC Drivers
bicrosoft OLE DB Provider for Olap Services 8.0
Microsaft OLE DB Provider for Oracle
Microsoft OLE DB Provider for SUL Server
kicrozoft OLE DE Simple Provider

k5D ataShape

F'rlcuveednr de bases de datos OLE para zervicios de dire
4

Mext =

chor ™
3

Aceptar | Cancelar |

Ayuda |

O

Una vez se ha seleccionado el driver de conexién a la base de datos (Microsoft OLE DB

Eusko Jaurlaritzaren Informatika Elkartea
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Provider for SQL Server) se debera indicar la conexidn a la base de datos:
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Ef) Data Link Properties X|

Provider Connection |.-’-'-.dvanu:ed| &l I

Specify the following to connect to SCL Server data:
1. Select or enter a server name:

SERVER j Fiefresh |

2. Enter information to log on to the server:

" Use Windows NT Integrated security
¥ Usze a specific uzer name and pazsword;

Il=zer name: Is?Sa_ea

BRI

Pazzword: I
[T Blank password [ Allow saving pazsword
3, (% Select the database on the server:
|S?3.&_Eﬁ-l |
i~ attach a databaze file az a databaze name;

[zing the filename;

| -

Test Connection |

Aceptar I Cancelar Ayuda |

Una vez de vuelta a la pantalla de transferencia de datos se ha pinchar en Transfer Data iniciando asi el
proceso de carga, aunque alertara de que todos los datos que contenga se perderan.

EA X

' Warning: ALL DATA in the target model will be deleted prior to uploading new data, Press OF bo continue, CAMCEL ko
# 4  abort

|_ Aceptar J[ Cancelar

Terminado el proceso se pincha en Close.

3.2 Conexion al repositorio/proyecto

Lo comentado a continuacion sirve como guia de conexién al repositorio remoto para cualquier tipo de
usuario.
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ENTERPRISE
ARCHITECT veo Search: | E]

My Profile_.
Set Local Optiens_
Help with Enterprise Architect .

Manage Projects Recent Projects

® Open a Project File..
= Create a New Project .
» Connect to Server..

Pinchando sobre Connect to Server... se muestra la pantalla de seleccion de driver de conexiéon a BD,
en la que se ha de seleccionar Microsoft OLE DB Provider for SQL Server. Después se indicaran los
parametros de conexion a la base de datos. Ahora hay que darle como nombre el codigo de aplicacion:

Connection Name & Type g|

Mame
[273a

[ atabaze Server

M5 SOL Server...

ok ] [ Lancel

Si la configuracién se ha efectuado de modo correcto, se cargara el proyecto EAP residente y existente
en la base de datos a la que se ha realizado la conexidn, pudiéndose observar en la vista Project Browser los
diferentes paquetes que componen el proyecto :
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B-F- R a W ap |

= (7 vistas

+ Modulo Funcional
Requetimientos Del Siskema
Ciagrama Clases

[®] Casos de Uso

Diagrama de Estado
Entidades Implicadas

R R R Ry R

EIF‘rl:uject Erowser @Resuurces D%F"n:q:uﬁ!rl:ilﬁ!s

En la pantalla principal se ofrece la posibilidad de abrir un proyecto ya existente, crear un nuevo proyecto
y/o conectarse a un servidor. Al haber seleccionado como repositorio de documentacion la opcion de base de
datos, el primer paso que debera realizar cualquier usuario (ademas del responsable de aplicacion) al iniciar la
aplicacion sera conectarse al repositorio a través de la opcién Connect to Server.

Si se ha activado la seguridad del proyecto y al usuario que intenta acceder se le ha dado de alta sin la
posibilidad de utilizar la seguridad Windows (no recomendado), le aparecera la pantalla de autenticacion:

&) Login to EA Repository [E

[dzer D

Pazaword: | |

[ ] Remember UserD

[ Lodin ][ Carncel ]

Este punto se explicara mas adelante.

3.3 Creacion de Modelos

Una vez creado el proyecto, el siguiente paso es la modelizacion de la aplicacion a partir de la creacién
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de los distintos tipos de diagramas que la herramienta proporciona.

3.3.1.Ejemplo: Requerimientos del Sistema

Como ejemplo de creacion de un diagrama, se va a realizar la creacion del diagrama de requerimientos
de un sistema, de tal forma que permita recoger tanto los requisitos funcionales como los no funcionales.

Antes de la creacion de los diagramas se ha de crear la estructura del proyecto.Para ello sobre la vista
Project Browser y sobre el objeto Model, pulsar el botén derecho y seleccionar la opcion New View.

Create New View

M arme
| Frequernimientos del Sistema

Set Yiew lcon Shle

LCancel

[
s

() Dynamic
) Clazs View

() Companent

) Deployment

De esta forma se ira generando una estructura de paquetes en la que almacenar los diagramas en base a
la funcionalidad y el tipo de diagramas que se vayan generando.
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Projeck Browser w 0 X

S B- %58 g
=l @Mc":lel

------- [=] requerimisntos del Sistemna

IEIF‘rDject Browser ‘ '@Resnurces |°@F‘rnperties
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Una vez creado el paquete, se selecciona y en el menu emergente que se muestra a través del boton
derecho del ratén, se ha de seleccionar la siguiente opcion Add -> Add Diagram

@ Prueba_GBB - EA HEE

© File Edt ‘iew Project Diagram  Element Tools  Add-Ins  Sethings  Window Help

0 obho PO PBe A e aDR B, A
g'- Start Page x |
= ~ — - - — —: I =
: ENTERPRISE ShA =R -
y Search: | | [
ARCHITECT 6.5 g = [ Model
My Profile... RropELes
Set Local Options. . Package Contral 4
| Online Resources & Tutorials |‘?_'E T || PP 7
. 18] Add Elemert... Ctr+M G 1
hianage Projects Recent = AddPackage... Chri+w e Engiteering 4
Add Model using Wizard. .. Build and Run 2
* Open a Project File... Petotore_GEEB
: Prusha GBB Import/Export 3
" Create a New Project.. =
e B Bigiunt PetStorehlew Transfarm Current Package Chr+-Mayusculas+H
opy a Base Project... Prushadosy ;
= Connect to Server .. PetStore Contents 3
EAExampls Bockiarks
Eat Search in Project Browser, ., ChrlHMayusculas+F
E:EI Copy Node Path ko Clipboard
— Save Package as UML Profile
Farn
b Sef View Icon...
| Moveup
B Movedown

X Delete 'Requerimientos del Sistema’

@ Help...

|4 ™. startPage 4 -.Pan & Zoom
5 ! ; +o| TE AN MR e B0 | &

Create new diagram COp UM R

G Motes
iy 7

v

[1 2 4% 7| Defaul sty 3

A continuacién se selecciona la opcién que se muestra en la imagen y se pulsa el botén Ok
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X

| [.-’-‘-.ut-:n]

Select From; Diagram Types:
[ UML Stuctural T Custom
l@ ML Behavioral :E'E Requirements
@ Exrtended F= Maintenance
&= Analysiz

:E'g Izer Interface

Requirements Diagrams are uzed to describe a
gyztem's requirements or features az a visual model.

] l[ LCancel ][ Help

Una vez creado el diagrama se debera realizar el disefio del mismo. Para ello al acceder a la ToolBox,
se encontrara activa la pestafia de disefio de Requirements
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@ Prueha_GBB - EA E@@

: Fle Edit Wew Project Diagram Element Tools  Add-Ins  Settings  Window  Help
D@l 2B RDS O DEC D MR ARE By - - OB ABE
imientos del Sistema’’ created: 19/09/2007 16:01:31 modified: 19/09/2007 16:01:31 100% 79 x ijEJ?FF.B.F.D.?".f‘.?f b
A BB ER R |
| Analysis [ = @Model

B- Requetimientos del Sistema
- B Requerimientos del Sistema

[

xoojbo | |

Use Case
Class
Composike
Communication
Interaction
Tirning
State

. .P;cti\u:ity
Component
Dieplovment
Cuskam

Profile

Metamodel IL x
¥ML Schema ,EProject EBrowser @Resnurces CQProperties
5 ‘Pan# Zaom T
| Reqyirements | - @l a @ @ ) | 73 —
1 B9 Package

Requiremgol— - - -
1Requvements : Elements for managing requirements. E

Feature
Object
Aggregation

Inheritance

Association

[ NNYOF @

Implements v

Maintenance - ol | 2
e . i'imientus del Sistema | b | @ Pan & Zoom :GNDtes
P A N T 8 R | Defaul Styie = 4 S I ‘ EB o ®aaa ik
Requerimisntos del Sistema B L

A

Para la realizacion del disefio se deberan crear tantos paquetes como grupos de funcionalidades se
vayan a recoger en la aplicacion. Para ello se debera arrastrar desde la caja de herramientas el objeto Package
al diseno.

Una vez arrastrado, se solicitara que se introduzca el nombre del paquete

New Package [EJ

Package Mame: |Hequerimientu:us Funcionales |

[ [u] J[ Cancel ]

Y se mostrara la ventana de propiedades del mismo:
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&5 Package : Requerimientos Funcionales

EJie

General | Require | Caonstraints | Link |I Scenarno | Files |

Phase:  [10  |Vesion:[10 |

Motes:

I ame: |Hequerimientu:us Funcionales |

Stereatype: | b Ilg.-’-'-.lgstract ol

Aythor: % | Status Proposed bl

Scope; Public s | Complesity: | Easy w

Alias; Language: | Java il
Kewwords: |

|Se trata del grupo de requernimientos funcionales que ha de cumplic la
aplicacidn.

Apply ] E Ok J[ Eancel H Help

A continuacién el diagrama presentara el siguiente aspecto:

Eusko Jaurlaritzaren Informatika Elkartea
Sociedad Informatica del Gobierno Vasco
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@ Prueba_GBB - EA E@

File Edt ‘ew Project Diagram  Element Tools  Add-Ins  Settings  indow Help
‘D o LDS P2 BB @ B ADR B A Ak [ BABE
Requirements Diagrarm: "Requenmientos del Sistema' created: 19/09/2007 16:01:31 modified: 19/09/2007 160742 100% 79 x _PrE]'_a_c_t_B_r_D_‘_""s'_ér b !
A BB ciEiE b F |
@Model |
=% Requetimientos del Sistema
B Requerimientos del Sistema

= ] Requetimientos Funcionales
z 'f'g Requerimientos Funcionales

Xogao |

=

Requeri mientos Funcionales

EProject Browser @Resources DQPererties
|Pan & Zoam v X

Qaaaea —— U —

=
¥
£ : : : ! £
4 Start Page\j\ *Requerimientos del Sistema L Requerimientos Funcionales I I ﬂPan&Zoom ENotes
gt _-_(:I\ Defaul Style . I o E= = - - oW @ 5:-,{,5 . p
7,
FLWUM S

Requirements Diagram:Requerimisntos del Sistema

Definidos los distintos tipos de requerimientos del sistema, el siguiente paso es agregar cada uno de los
requerimientos en el tipo correspondiente. Para ello se debera seleccionar el tipo de requerimiento en el que se
quiere agregar un nuevo requerimiento y del menu emergente del botén derecho del ratén seleccionar la opcién

Add -> Add Element
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@ Prueha_GBB - EA B@@

: Fle Edit Wew Project Diagram Element Tools  Add-Ins  Settings  Window  Help
DEE B0 RDS BO. BB & e AGR . A - Auk~ OB AB
Fequirements Diagram: “Requenimientos del Sistema’" created: 19/09/2007 16:01:31 modified: 19/08/2007 16:05:50 100% 79 x|
A BB c R
=

Model

xoojbo L |

B- Requetimientos del Sistema
- B Requerimiertos del Sistema

Properties...

Package Control 3

Add Diagram... | Add 3

Requeri miertos Funcionales

#idd Element... M | S :

0 | 52

Add Package... Chrl+wy
e ! Code Enginesring 3

Add Madel using ‘Wizard. .. Build and Run 3

ImportfExport 3

Transform Current Package ChrHMayusculas+H

T Contents 4
Bookmatks

E Eﬁ Search in Project Brawser, . Chrl+Mayusculas+F
Copy Mode Path ta Clipboard

Save Package as UML Profile

l® |

@ Mave up
B Move down

¥ Delete Requerimientos Funcionales'

@ Help...

b

< | ¥
4 ‘StartPage™,  *Requerimientos del Sistema | Requerimientos Fundonales | b | @panzzoom | Bctes
2 4" 7| pefaul style - J- o o ao] oo AL Ba Bo | o B AL | @) @ | G

Insert a new element in tree SR ¢ S

A continuacién se mostrara una ventana con las siguientes opciones:
= Type: Tipo del elemento a agregar

= Name: Nombre del elemento.
= Stereotype: Estereotipo del elemento a afadir.

21/178



- Eusko Jaurlaritzaren Informatika Elkartea
l Sociedad Informatica del Gobierno Vasco

New Element [E|
Tvpe: | Fequirernent V_I

Mame: |Hequerimientn1 | [gut.:.]
Stersotype: | e |

Open Properties Dialog on Creation
Cloze dialog on OF

[ lieadd to Current Diagrar

[ ok ][ Cancel ][ Help ]

Por defecto, el campo Stereotype tiene el valor Functional. Se puede introducir un estereotipo particular
que la herramienta es capaz de almacenar para la siguiente operacion.
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Finalmente el diagrama de requerimientos quedara tal y como se muestra a continuacion:

@ Prueha_GBB - EA EE|

Fle Edit Wiew Project Diagram  Element  Tools  Add-Ins  Settings  Window  Help

D& b ROS Fo. B%c 2 e AR . 4 - Juk- B ABE
g Fiequirements Diagram: "Requerimisntos del Sistema''  created: 19/09/2007 16:01:31 modified: 19/09/2007 16:15:47 100% 79 > LRGeS t :
= AlBr B EE 5P i

B ([ Model
= Requerimientos del Sistema
B Requerimientos del Sistema
[ MR cucrimientos
e 'Fg Requerimientos Funcionales
- =) Requetimienta 1

Funcionales

Requeri miertos Funcionales

=) + Requerimienta 1

E Project Browser @ Resources C@ Properties

|Pari& Zoom v RX
@aeaa—
=
20
i3 ! &
4 “Start Page\\h Requerimientos del Sistema iiequeri'm\entos Funcionales ] I 1 Pan&ZDDm GNDtES
2 4" 7| Default style - g B G IR o, P =R s SO O @ | S b, B
Read S| MU

3.4 Exportaciéon/Importacion XMI

Una de las importantes ventajas que proporciona Enterprise Architect, es la implementacién que realiza
de la especificacion de intercambio de diagramas (XMI) que le permite la importacion y exportacion de los
modelos hacia y desde otras herramientas de modelado.

Para la realizacion de la exportacion se debera seleccionar de la Project Browser, el paquete que se
quiera exportar y pulsar el botén derecho del raton y seleccionar Import/Export -> Export package to XMl file
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@@ Petstore - EA - 30 Day Trial & x]
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Se mostrara un cuadro de dialogo con las siguientes opciones a configurar:

= Filename: Nombre del fichero al que exportar el diagrama

= Stylesheet: Plantilla a utilizar en la exportacién de los datos.

= Export diagrams yes/no: Seleccionar si se exportan los diagramas

= Use Unisys Rose Format: Seleccionar si se exporta en formato Rose UML 1.3 o en formato
XMI 1.1

= Format XML output - yes/no: Seleccionar si se genera un XML de salida legible (Implica una
mayor duracién del proceso)

=  Write log file: Seleccionar si el proceso se escribe en un log. El log se guardara en el mismo
directorio que el fichero XML.

= Use DTD: Seleccionar si se utilizar UML 1.3 DTD. Asi se validara el estado correcto del modelo
y que no se han producido errores sintacticos.

=  XMI 1.0: Indicar si se exportara en formato XMl 1.0

=  XMI 1.2: Indicar si se exportara en formato XMI 1.2

= XMl 1.1: Es la opcién por defecto, generar el fichero de salida en formato XMI 1.1

= Exclude EA Tagged Values: Elimina la informacion especifica de EA en la exportacion.
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Export Package to XMI ] x|

oot
FPackage

Filename: I:"-.Du:u:uments and Settingz\gbruna ELROHE LP-BILBAD “Miz documentozsaa. smil |

IEasu:us de Llzo

Shilesheet | j [Optional stylezheet to post process XMI content]
— General Options — For Export to Other T ools
¥ Export Disgrams ¥ Enable full E4 Roundtip
I Foimat %I Dutput MMl Type: [UMLIZ0MITA) ]
v ‘wiite Log file
W UseDTD [T Urizpe/Bose Format
I Generate Diagram Images [T Esclude E& Tanoed Walies
Er Iﬁ Warning: These optionz are for exporting
§ E& model elementz to other tools only.

it i | Esport I LCloze | Help

Frogress

Finalmente pulsando el botén Export se realizar la exportacion y a través del boton View XMI se podra
visualizar el fichero generado.

Es importante indicar que cuando se realiza la exportacion con XMI 1.0 con EA, se produce la perdida de
datos debido a las limitaciones de dicha versién.

Para la realizacién de la importacién, del menu anterior se debera seleccionar Import Package from XMi.
Se mostrara un cuadro de dialogo con las siguientes opciones a configurar:

= Filename: Nombre del fichero que se va a importar.

= Import diagrams: Indicar si se van a importar diagramas.

= Strip GUIDS: Seleccionar para eliminar la informacioén de los identificadores universales del
fichero a importar. Esto permite la importaciéon de un paquete dos veces en el mismo modelo.

= Write log file: Seleccionar si el proceso se escribe en un log. El log se guardara en el mismo
directorio que el fichero XML.
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Import Package from XMI x|

Fioot :
Pt <ms |\-’|stas

Filerarnea |I::'\D|:u:uments and Settingzhgbruna EUROHELP-BILEAD Miz docurnentash, |
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[ Ship GUID's v ‘wiite Log fils
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Wiem | | Impart I Cloze | Help |
#=MI I mport Progress
I |

Es importante indicar, que cuando se realiza la importacion sobre un paquete, se los pierden los datos
existentes al realizar la importacion.

3.5 Documentaciéon

Una vez creados los modelos, Enterprise Architect proporciona la posibilidad de la generacién de
documentacioén a partir de la informacién introducida en cada uno de los elementos que se han creado en los
distintos modelos, para ello posibilita bien la utilizacion de plantillas predisefiadas o la implementacién de
nuevas plantillas.

3.5.1.Generacion Documentos Word

Para la generacion de documentacion a partir de las plantillas predefinidas por el sistema, se debera
seleccionar desde la Project Browser se quiere exportar a un documento Word, pulsar el botén derecho del
raton y del menu emergente seleccionar la opcién Documentation->Rich Text Format(RTF) Report
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Se mostrara un cuadro de dialogo con las siguientes opciones y botones:

= Root Package: El paquete seleccionado para la generacion de la documentacion

= Output to file: Ubicacion y nombre del fichero de la documentacion generada.

= Switch Generator: Permite el acceso a la ventana Legacy RTF Report.

= Generate Options: Abre la ventana de opciones del documento.

= Resource Document: Permite almacenar la configuracion actual como una definicién de
documento.

= Use Template: Permite seleccionar la plantilla a aplicar.

= Edit Current: Edita la plantilla seleccionada en el campo anterior. Este campo solo esta activo

en caso de que se encuentre seleccionada una plantillada disefada por el usuario.

Generate: Boton que genera la documentacion.

Help: Muestra la ayuda de EA para la generacion de documentacion.

View: Permite la visualizacién del documento generado.

Close: Cierra la ventana actual.

Use internal Viewer: Check que implica la visualizacion de la documentaciéon como una

ventana mas del EA.

= Use Language Substitutions: Check que activa la sustitucion de las palabras configuradas
anteriormente.

= Language: Botdn que abre la ventana de sustitucion de palabras.

Generate RTF Documentation

Root Package: C '
Clutput b file: [D:ADAT OSACO00608C Mis documentassinterviews. RTF i D
[ Switch Generatar.... ] [ Fenerate Options. .. ] [Hesu:uuru:e Qu:u:ument...]
RTF Docurmnent
Use Template: | {use case templatc ]
[ Manage Templates. .. ] Edit Cument [ Generate ]
[ Help ] [ Wi, ] [ Close I
Dptionz
[ ] Usze Intemal Viewer [ ] Use Language Substitutions
Progress:
| l ]
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Finalmente con el botén Generate, se creara el documento y con el botdn View se podra visualizarlo.

A continuacién se detallaran las distintas opciones que se han presentado en la ventana anterior y que
implican acciones mas alla de la seleccion de un indicador o la introduccién de datos:

Generate Options

Este botdn presenta la ventana que permite gestionar los filtros que se van a aplicar asi como el
orden en que se van a mostrar los elementos en la generacion de la documentacién. Se presentan las
siguientes opciones de configuracion:

= Only incluye objects: Permite filtrar los elementos por la fecha de creaciéon o modificacion.

= Where Package Phase: Permite filtrar por el valor del campo Phase del paquete.

» With Element Status: Permite filtrar los elementos en funcion de su estado.

= Generate Options: Abre la ventana de opciones del documento.

= Packages By: Ordena los paquetes en orden ascendente o descendente en funcion del
nombre, la fecha de creacién o modificacidn, o en estructura de arbol.

= Elements By: Ordena los elementos en orden ascendente o descendente en funcién del
nombre, la fecha de creacién o modificacidn, o en estructura de arbol.

= Diagrams By: Ordena los diagramas en orden ascendente o descendente en funcién del
nombre, la fecha de creacién o modificacidn, o en estructura de arbol.

= Hide ‘note-less’ elements: Excluye de la documentacién todos los elementos que no tengan
notas introducidas.

= Skip root package: Excluye el paquete padre de la documentacién final y solo muestra los
paquetes hijos.

= Overwrite document fields: Con la opcién deseleccionada se muestran los campos definidos
en la plantilla se muestran con sus valores correspondientes. Con la opcién seleccionada se
sustituiran dichos campos por el texto actual.

= No bookmarks: No inserta los marcadores RTF en la documentacién.

= Diagram Format: Permite indicar el formato de las imagenes de los diagramas a introducir en el
documento.

= Adjust Heading Levels: Permite gestionar automaticamente al generador los estilos en funcion
de la profundidad del documento.

= Exclude Details for: Excluye los elementos seleccionados de la lista del documento final.
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Document Options

Filter Exclude details for
COnly include objects: I' | | b : !|:| [B/09/2007 (W | Action ~
— - Bctivity
“where Package Phase: | b | |-'“-"-|| | ActivityFinal
Activitylnitial
With element status: | V| | | ActivityP artition
ActivityR egion
Azkar N
Order Artifact
Packages by: | Tree Order w | !.-'-‘-.sc:ending L | EE:ES:’P
: Choice
Elements by | Tree Order w | !.-'-‘-.su:ending w | Class
: : o = Collabaration
Diagrams by ITree Order ¥ || Azcending ¥ | Collabaration Mags
- - CollabarationDccurence
Advanced EDF"WUE”‘
S , : Canstraint
[ ] Hide 'note-less’ elements Diagram Format; |Metaﬁ|e w | Decision
[]5kip root package Dep!nymentSpecificatinn -
[ ] Dwenarite docurment fields A : : Y B oo
just Heading 2 -
[] Mo bookmarks Lewvels: | Heading 3 o |
[ k. l [ Cancel ] [ Help ]

Se ha de indicar que las configuraciones realizadas en la generacion de la documentacién no seran
guardadas, por lo que la proxima vez que se vaya a generar el mismo documento se deberan repetir las
especificaciones aqui indicadas.

Resource Document

La seleccion de dicho botdn presenta la siguiente ventana

Save current as document definition EJ

Enter YWalue: iEasu:us de Uzo |

Como se ha comentado anteriormente, permite la grabacién de la configuracion de los datos introducidos
en la ventana Generate RTF Documentation y generar de esta manera una plantilla de configuracion, que
permita su posterior reutilizaciéon. Dicha plantilla es accesible desde la vista Resources -> Documents-> RTF
Documents ->
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Resources

= ﬁ Resources

ﬁ MO Technologies

[ UrL Profiles

LML Patterns

Templates

‘Web Style Templates

RTF Stvle Templates

=| Linked Document Templates

= @ Dacurnents

= E] RTF Documents

Casos de Lso

ﬂ Matrix Profiles

Favaorites

Skyleshests

-

EIF‘rl:uject Erowser @Resuurces D%F‘n:q:uﬁ!rl:ilﬁ!s

Switch Generator

Este botdn presenta la ventana RTF Report, que permite la generacién de documentacién de una forma
automatica ya que desde este ventana se puede seleccionar el contenido y el formato de los datos a mostrar en
el documento final, introducir el nombre del informe, seleccionar la cabecera a utilizar, notas adicionales, la
plantilla, etc.

Asi mismo, permite crear filtros, detalles a incluir por cada objeto, tipos de elementos a excluir, si se
desea procesar los paquetes hijos, si se van a mostrar los diagramas y el formato de los mismos.
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3.5.2.Diseio Plantillas

Para realizar el disefio de nuevas plantillas se ha de acceder a la ventana Generate RTF Documents tal

y como se indica en el punto anterior.
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EJie

Generate RTF Documentation

oot Package: |:E|:E:|:|:E: de zo |
Dutput ta file: |DZ"-.D.":".T|:|S"-.|:|:| N0G0ECHKMiz documentozinterviews B TF | [ ]
[ Switch Generatar.... ] [ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurment

Use Template: | [use caze template)

&l

[ Manage Templates. .. ] Edit Cument [

Generate ]

Help ] [ Cloze ]

Dptionz
[ ] Usze Intemal Viewer

Progress:

[ ] Use Language Substitutions

Pulsando el botbn Manage Templates se accede a la ventana de mantenimiento de las plantillas

disefiadas por el usuario.

RTF Templates

Defined Templatesz

X

Plantilla Cazos de Uso
Plantilla Detalle Requizsitos
Plantilla ndice Fequizitos
Plartilla todulo Funcional
Secuehcia

[: Delete Selected J [ Few

. || Edt. || Close || Hep |

[ Irmpart From Reference File ]
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EJie

Para crear una nueva plantilla bastara con pulsar el botén New y se mostrara una ventana en la que
introducir el nombre de la nueva plantilla y opcionalmente seleccionar una plantilla de la que partir en el nuevo

disefio.

New Document Template

[ ew template: |Easu:us de Llzn

:EDD_',' template: :_ L8 CAsE Cenano tEEFI'IFllEltEE]

| ok

,] [ LCancel ] [

Help ]

A continuacion y pulsando el botén OK, se muestra la herramienta de disefio de plantillas
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El editor consiste en tres areas bien diferenciadas:

= Sections: Se trata de una estructura en arbol que permite seleccionar los distintos objetos que
se van a incluir en la documentacion final.

= Content: Contiene la estructura para la definicién de los contenidos del documento. Con el
boton derecho y en una seccidon delimitada por la eleccion de los elementos del apartado
anterior se podra agregar propiedades de cada objeto seleccionado.

= Menu: Proporciona un grupo de funcionalidades para la modificacion de textos e insercion de
estructuras definidas.

Para agregar una nueva seccion en el documento, se debera seleccionar del apartado Sections, aquella
que se quiera incluir en el documento. En este caso, se ha seleccionado la seccion Constraint, del objeto

Package

&) Casos de Uso

File Edit “ew Insert Font Paragraph Table Other Help

Sections ] Cantent

&[] Model
; : [ Glossary
[ lssues
[ Tasks
. Package
. Package Element
-~ [[] Requirement
.~ [] Extenal Requirements
- - [#] Canstraint
-~ [[]Tagged Yalus
¢ [ Scenario
- [CFile
i Test
- [[]Change
-~ [Defect
- [ lssue
¢ Task
- - [Risk
-~ []Effort
o[ Metric
-~ []Resource
[ Madel Dacument
. [¥] Elemnent
- [] Requirement
. [] Extenal Requirements
- [ Tagged Value
- [[] Custam Praperty
-~ [IFile
Co e Test
. [[]Change
- [ODefect
i lssue
C o[ Task
- ~[JRisk
- []Effort
© O Metrie
.~ []Resource
[ Transition
- =[] Connectar
- B[] Source
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ﬂ@@.|§o'—‘1@.|ﬂ“|aﬁ|%fﬂ @[ | @ (100 v]|
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| Mormal vI|Ar|aI ;-“10 ¥ BIU A”gg ===
I T LT R ST ! i 1 5 -.---s-d
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3
Use-Case*Scenario'Reportd

package->a
Package. Pl Narme)d
pa(,kagrelement' -d

.insetsPackage-Elermentscontentshere... d
3
d
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nzersConstraintscontentshere. .3

<-consrainid
d

packagaelemenla
element:>
2}

Detail: = i

UzesCaseM ame - {Element Hame}=

Status: = TElement Status] == Versiomn: - Fhase: -{Element Fhaze}=

{Element Version
Author: = {Element Authorfs
Createdeon @ TElement DateCre [ Modifiedson: = {Element DateModifiedShort}=
atedShort}=
Notes:= {Element Motes} =

Scenarios: =

( SCenanios
Constraints: =

{ElemC onstrant Type} i {ElemC onstrant Name}» i { ElemC onstraint N otes) =

[Page:1  Line:1d  Cold

i _|

Una vez seleccionada se visualizara en el apartado Content dicha seccion entre tags y en color amarillo,
indicativo de que no se puede eliminar manualmente, ya que la unica forma de eliminarla es deseleccionarlo del

apartado Sections.
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Una vez seleccionada la seccién, ubicando el cursor entre los tags, y a través del boton derecho del raton
se muestran las propiedades del objeto que se pueden integrar en el documento:

) Casos de Uso

File Edt view Insert Font Paragraph Table Other Help
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| ol DR 2 3iiii4eiiiii5 g
&[] Package A
E Package Element i UseCase3cenatio-Reports I Tuesday, 1 5-Marche:
- ~[] Requirement A
[] External Requirements
[#] Canstraint T e . a
| s vakia 3 Use+Case*Scenario*Reportd
- [ 5eenana package > 4
[Fie Package Pk Name)
[ Test d " ; 3
Ch. Dd(. ageelement =
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|
fe -
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i Eg;rkt BOHS ran
o 3
[]Metic in MameJtcontentshere...a
[ Resource <ol Notes
- [ Model Document d L
= [#] Element <:I-|Ja Status 3
- [] Requirement t;em Type
[] External Requirements =i | Weidht
[[] Tagged Yalue Det = i
[T Custor Prapety TUseaCaselame s {Element Name}=
C]File Stafus:= (Element Btatus} - Version - Phase {Element Phass}=
C [ Test {Element Version }
- []Change Author= {Element Author}=
[ Defect Created=on= {Element DateCre | Modified=on:= {Element DateModifiedShort] =
[lssue atedShort} o
[ Task Motes: {Element Notes}=
E Risk Scenarios:x
: Effart scenario>d
© [ Metric TElemScenaio Type) = {Elemacenanodcenaro] = | {Elemd cenano M ofest =
 [JResource <-scenariot
- [ Transttion C nnsu:amts: 8
- B[] Cannectar constraint=d : :
g [ Source s FElemConstraimt Troet- {ElemConstraint Nate s [ ElemConsttamt Foteshs
; [ Elerment NS [Page:1  Lnex16  Cold v
: 1 Tanned Value o8| & ¥

Para un mayor conocimiento del manejo del disefiador de plantillas se aconseja la utilizacion del siguiente
manual proporcionado por EA:

http://www.sparxsystems.com.au/downloads/whitepapers/Working with the RTF generator.pdf

3.6 Modelo de seguridad

Enterprise Architect Corporate Edition permite aplicar seguridad de acceso al proyecto, ademas de
habilitar el acceso unico a cada modelo con objeto de impedir modificaciones paralelas no deseadas.

Aunque en cualquier proyecto, y por defecto en su creacién, el modelo de seguridad aplicable a partir del
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propio Enterprise Architect, esta deshabilitado, se recomienda mantenerlo activado. Asi, el responsable de
proyecto una vez generado (ver el apartado “Crear proyecto” del presente manual) debera ejecutar los pasos

indicados a continuacion.

Importante: El proceso descrito a continuacién solo lo debera ejecutar el responsable del proyecto.

Para poder activar la seguridad se debera tener activo el propio proyecto. Si éste no dispone de politica
de seguridades aplicada, se activara accediendo al Project = Security=> Enable Security.

& PetStore_GBB - FA QEI

File Edit Wiew W Diagram  Element  Tools  Add-Ins  Settings  Window  Help
0 D’}' Z_Z_- {Za | Oy Add Package... Chrl+4 qg G Iﬁ Eﬁ 3 I% @ E]:h 3&. all
g StatPage | Add Diagram. .. Chrl+y
g — & Add Element... Chrl+M ; :
@ ARCH Documentation 4 = _ E—
| Source Code Enginesring 3
Build and Run 3
Database Engineering ]
£
Model Transformations 3
Model Yalidation 3
e Web Services 3 fit
#ML Schema 3
= Open a {eba_GEB
= Create a| Jecuricy i
= Copy a f Wersion Control +
= Connect Import/Export »
Manage Baselines...  Chrl+Al+E
e Use Case Metrics...
il View Project Statistics. ..
|'®a Enable Security. ..

4 ™. Start Page

s 0 7 | Defaulk style ~ -

A

& =B 1)

o 'Prgjg_c_t_srowsz_ar v I x|
- E- a5 d R
[ =2 @Vistas
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@ Requetimientos Del Sistema
Diagrama Clases
[®] casos de Uso
(4] Diagrama de Estado
Entidades Implicadas

E}Project Browser @Resources Q@Properties

|Pani & Zoom v R X

b | @ Pan & Zoom | [\ QS

7

Enable security in model

]

Se solicita un cédigo de autorizacion que se debera completar.
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Enter authorization EJ

Enter autharization key:

[ k. ] [ Cancel ] [ Help

Nota: Esta clave se facilita cuando se hace la compra del producto.

Una vez introducida informa de que ademas se ha generado un usuario administrador por defecto:

EA X

' Security has been enabled on the current model. You can now login as 'admin’ with the passward 'password’ and
. create and adminisker users, groups and permissions’

Aceptar

Una vez activada la seguridad se recomienda marcar la opcion Require User Lock to Edit, lo que
garantizara que no habra actualizaciones indeseables por modificaciones concurrentes de mas de un usuario al
mismo objeto. Con esta opcion el usuario antes de poder realizar cualquier modificacion debera bloquear el
objeto, asegurando entonces su uso exclusivo. Asi, una vez finalizado el cambio debera desbloquearlo.

Enterprise Architect pide confirmacion antes de efectuar esta operacion.

’T ¥ou are about ko change the locking mode so thak elements can QMUY BE EDITED if wou LOCE Ehern,
L3

This represents a complete inversion of the current behavior, and vou should only proceed if vou are certain of the
ConseqUences,

Do wou wish to proceed?

Enterprise Architect también admite otros modelos de bloqueo menos restrictivos, por lo que sera
decision del responsable de aplicacidén adoptar la mejor opcion para cada caso.

Una vez se ha accedido al proyecto con las credenciales autorizadas se podran realizar sobre el proyecto
seleccionado las operaciones asociadas a los diferentes perfiles que se hayan creado para el proyecto, y en
funcion del usuario autenticado podra efectuar aquellas operaciones que le estén permitidas.

Una vez ha sido habilitada la seguridad, se puede acceder a las otras opciones de administracion.
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3.7 Trabajo en grupo

3.7.1.Mantenimiento de usuarios

Importante: El proceso descrito a continuacién solo lo debera ejecutar el responsable del proyecto.

Para gestionar los usuarios y la asignacion de estos a los posibles grupos y permisos identificados para el
proyecto acceder al menu Project->Security=>Maintain Users:

Ilzer Detailz Set Permizsions

Login: |

Firztname;

Surname;

Department;

o

[ ] Accept Windows Authentication

|lzers: MNewva S ave Drelate
Sumame Firstnarne Login
Adrministrator The adrnin

Para efectuar un alta de un usuario en el sistema, se pulsara el botén de New, el cual permite acceder al
apartado de User Details con todos los campos en blanco para proceder a su definicion:
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Idzer Detailz
Logir:
Firzsthame:

Surnare:

Department;

Se recomienda utilizar el sistema de credenciales compatible con las propias de acceso al sistema
Windows, para ello bastara tan solo con activar la casilla Accept Windows Authentication. Una vez introducida
la informacién, se procedera a almacenar la misma pulsando el botéon Save apareciendo entonces en la lista
Users.

Para efectuar una actualizacion de los datos asociados a un usuario en el sistema, se procedera a
seleccionar previamente al usuario de la lista, se cumplimentara la informacion del usuario a modificar existente
en el apartado de User Details con todos los campos con la informacion original ya cumplimentada y pulsar
Save.

Para efectuar un borrado de un usuario del sistema, se procedera a seleccionar previamente al usuario
de la lista, se pulsara sobre el boton Delete, el cual realizara el borrado en el sistema. Es de resaltar que el
borrado es fisico y que el sistema no pide confirmacién del mismo, por lo que se debera estar muy seguro de la
operacion a efectuar, ya que la misma no es reversible.

Si lo que se desea es asignar o quitar privilegios al usuario, se procedera a seleccionar previamente al

usuario de la lista, y en funcion a los privilegios que se deseen asignar o quitar al usuario, se seleccionara una
de las tres opciones posibles:

Set Permizzionz

[ araup Membership ]

[ Single Permizzions ]

| viewar |

La opcion Group Membership, permite la asignacion/desasignacion de un usuario a un grupo. Una vez
pulsada esta opcién, mediante botones de opcidn, los que estén marcados generaran la pertenencia a los
grupos marcados y a los que no estén marcados, el usuario no dispondra de pertenencia a ellos:
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User Groups

X

Tick Required Groups:

Adriniztratars

t Ok, I|[ Cancel ] [ Help

La opcion Single Permissions, permite la asignacion/desasignacion de un usuario a los diferentes
permisos existentes en el sistema. Una vez pulsada esta opcidén, mediante botones de opcion, los que estén
marcados generaran la pertenencia a los permisos y los que no estén marcados el usuario no dispondra de
pertenencia a ellos. Se recomienda asignar permisos a través de la pertenencia a un grupo al cual se le asignen
los permisos deseados:

User Permissions [t?

—_

Tick required permizzions

Sdrinizter Database (A ok
Change Pasaward

Check Data Integrity
Configure D atatypes

Configure Images
Configure Packages

Configure Resources ==

Configure Stereatypes

Configure Wersion Contral

E xport x|

Generate Documents

Generate Source Code and DOL

[rpart =kl
Lock Elements b

La opcion de View All es una combinacién de las dos anteriores, por lo que se veran todas las opciones
juntas y mezcladas en la misma pantalla de asignacion, desasignacion.
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All user permissions

Azzigned permizsions:

|[#] &drnirizter D atabase Al
Change Pagsword il
Check [ ata Integrity

Configure D atatypes

Configure Images

Configure Packages

Configure Resources

Configure Stereatypes

Configure Wersion Contral

Export 1

Generate Documents

Generate Source Code and DDL

Import M|

[¥]Lock Elements |

3.7.2.Usuario administrador

Importante: El proceso descrito a continuacién solo lo debera ejecutar el responsable del proyecto.

Para evitar accesos no permitidos con perfil de administrador es basico actualizar los datos del usuario
administrador creado por defecto.

Acceder al menu Project-> Security>Maintain Users, y seleccionar de la lista Users” el referenciado
como Administrador. Poner como login el cédigo de usuario utilizado para entrar al dominio Windows de
EJGVNET y marcar Accept Windows Authentication, con lo que no pedira usuario/password si el usuario se
encuentra autenticado en el dominio.

Es recomendable generar otro usuario con permisos de Administrador (perteneciente al grupo
“‘Administrators”).

3.7.3.Mantenimiento de grupos

Importante: El proceso descrito a continuacion solo lo debera ejecutar el responsable del proyecto.

Para gestionar los grupos y los permisos o privilegios identificados para el proyecto acceder al menu
Project>Security>Maintain Groups:
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Security Groups

[aroup Mame
Descriptian ;
Groups: Hew
. Group Mame Dezcription
Adrminigtrators System Adminiztrators [
Cloze ] [ Help

Para efectuar un alta de un grupo en el sistema, se procedera a pulsar el botén de New, el cual permite el
acceder a la parte superior de la pantalla, con los campos de Group Name y Description en blanco para
proceder a su rellenado:

Eroup Mame

Dezcription

Groups; Hew

Una vez introducida la informacién, se procedera a almacenar la misma pulsando el botén Save, el cual
se habilita en el momento de haber cumplimentado toda la informacion asociada al grupo.

Para efectuar una actualizacion de los datos de un grupo en el sistema, se procedera a seleccionar
previamente al grupo de la lista, se cumplimentara la informacion asociada al grupo con todos los campos con la
informacion original ya cumplimentada y una vez introducida la nueva informacion, se procedera a almacenar la
misma pulsando el botén de Save.

Para efectuar un borrado de un grupo del sistema, se seleccionara previamente el grupo de la lista, y se
pulsara sobre el botdn Delete, el cual procedera a realizar el borrado del grupo del sistema y a eliminar
automaticamente las asignaciones de usuarios pertenecientes a ese grupo. Es muy importante sefialar que el
borrado es fisico y que el sistema no pide confirmacién del mismo, por lo que se debera estar muy seguro de la
operacion a efectuar, ya que la misma no es reversible.
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Security Groups [Z|

[aroup Mame ipetsturelﬁrnup |

Description | petstareGroup
L

Set Group Permizsions

Groups: New Save

Group Mame Dezcription

—_
e

Adrminigtrators System..ﬁ.dministratnrs

petztorelatatp petatorelaralp

Cloze ] [ Help

Si lo que se desea es asignar o quitar privilegios al grupo, se procedera a seleccionar previamente al
grupo de la lista, y en funcion de los privilegios que se deseen asignar o eliminar al grupo, se iran marcando o
desmarcando las casillas de opcién habilitadas para tal fin:

Group Permissions

Tick required permizsions

[]Administer D atabasze ~
[]Change Passward
[[]Check Data Integrity
[]Configure Datatypes

[[] Configure Images
[[]Canfigure Packages
Configure Resources

[ ] Canfigure Sterectypes
Configure Yerzion Contral
[ ]Expart =kl

[ ]Generate Documents

Generate Source Code and DOL

[ TImport =l

i anl Elarmants

[

[ k. ][ Cancel ][ Help ]
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3.7.4.Gestion de bloqueos

Si se ha activado la opcion Require User Lock to Edit (recomendado) cuando un usuario bloquea un
objeto, debera liberarlo explicitamente cuando finalice su tarea de modificacion. Esto evidentemente puede
generar problemas, bien por olvido, bien porque sea necesario adquirir el objeto en un momento dado y el
usuario que lo tiene bloqueado no esta disponible, etc.

Es importante recordar que para poder bloquear un elemento el usuario debe tener perfil de administrador
o tener asignado el privilegio Lock Objects .

Para consultar y gestionar los diferentes bloqueos activos para el proyecto acceder al menu
Project>Security>Manage Locks:

Wi Locks Faor
&= al () Groups Only () Uszers Only
T e [ Select Al ] [Select ﬂnne]
Type Mame I1zer roup Timestamp |
Element Component?2  admin 13/09/2007
Elerment Buzande ... admin 1940942007
Elernent Component]  admin 13/0942007
Element Afadir avizo  admin 1340942007
Element Afiadir una...  admin 19/09/2007
Muevo Siz..  admin TX09.2007
Elerment ASiztema ... admin 19/0942007
Elerment taodulo Fu...  admin 13/0942007
Diagram ASisterma .. admin 13/09/2007

Afadicavizo  admin 13092007

Diagram Modulo Fu...  admin 19/03/2007

(oo ] (e

Es importante recordar que esta opcion solo estara activa para usuarios administradores y para aquellos
a los que se les asigno el privilegio Security - Manage Locks.

Para desbloquear objetos, se puede seleccionar uno por uno de la lista, o pulsando Select All se
marcaran todos, pinchando después Unlock Selected se desbloqueran todos los seleccionados

Si ha activado la seguridad y la opcion Require User Lock to Edit, para bloquear un elemento, hay que
posicionarse en la pestafia Project Browser sobre el objeto que se quiere editar, y pulsando boton derecho
ejecutar la opcion Apply/Release User Lock...
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Set User Lock

Action

(=) pply User Lock )

() Release User Lock

IIE

Include Child Packages

Esta opcién de menu también permite el desbloqueo al posicionarse sobre algun objeto bloqueado
previamente.

Set User Lock

Action

3
() Apply User Lock .

Include Child Packages

3.7.5.0tras funciones

Cambio de password

Opcidn que permite la gestion de la contrasefia del usuario activo. Desde este apartado se permite
cambiar la contrasena para el usuario que esta identificado en el proyecto en ese preciso instante. Para
ejecutarlo se debe acceder al menu Project->Security->Change Password

Change Password @

-
Enter old password: | |

Mew pazsword: |

Fetype riew: |

)
fw
In]
]
o1

Login como otro usuario

Desde este apartado se permite cambiar el usuario identificado o autenticado en el proyecto. Para
ejecutarlo se debe acceder al menu Project>Security>Login As Another User.
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% Login to EA Repository
I gerd D au:l-n.';ir'.l
Pazsward:

Remermber UzelD

[ Login l [ Cancel

Se permite un maximo de tres reintentos en la introduccién de un usuario y contrasefia validos para
acceder al proyecto. Si por un casual se intentara por mas de tres ocasiones consecutivas y estas fuesen
incorrectas o erréneas, el Enterprise Architect mostrara un mensaje de error, y realizara una salida del acceso al
proyecto seleccionado.

3.8 Modelado Datos con EA

El modelado y el disefio de base de datos no se encuentran explicitamente cubiertos por la especificacion
UML, pero si estan recogidas en Enterprise Architect en la funcionalidad de Modelado de Datos UML. Dicha
funcionalidad permite el mapeo de objetos de base de datos como tablas y sus relaciones, a objetos UML como
clases y asociaciones. Asi mismo, permite la creacién de claves primarias, triggers, constraints, etc.

Enterprise Architect soporta la importacién de los esquemas de bases de datos de las siguientes bases
de datos :

DB2

InterBase

MS Access

MySQL

Oracle

PostgreSQL

MS SQL Server

Sybase Adaptive Server Anywhere
Firebird

3.8.1. Creacion Modelo de Datos

Para crear un modelo de datos, lo primero que se debera seleccionar es un diagrama en el que ir creando
los objetos, para hecho se utilizara como base el modelo que proporciona la herramienta para el disefio de base
de datos. Para ello, sobre el elemento root Model, pulsar el boton derecho del ratéon y del menud emergente
seleccionar la opcion Add->Add Model Using Wizard

De la ventana que se muestra se ha de seleccionar el modelo Database.
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X

i

o

(3 (3 Phed: [
7 L I R

Campanent
Deployment

Testing

Maintenance

Project Managermenkt
User Interface

|

Select model{s) to add ko vour project Select From: Ecummnn w |
: Marne Descripkion
E {— Business Process WarkFlow and information processing
= r Requirements Business rules, Features, functional and non-Functional requin
E| r IJse Case System behavior described with Use Cases and Actors
TE [ Domain Madel Damain specific objecks and their relationships
= IT: Class Twpe hierarchies, relationships and abstractions
W

Database schema, tables and peristent data

Software artifacts and components

Phrysical hardware, clients and network topologies
Test plans, kest resulks and tesks

Issues, bugs and changes

Versions, schedules, resourcing and projeck metrics
User Interface definitions

[ Al ][Nune]

a4 ” Cancel J[ Help

Pulsando el boton OK el sistema creara una estructura para el modelado de base de datos, Data Model.
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2-F- o2 a 5 a P |
= @ Madel

= F.eguerimientos del Sisterna

i - Fo Requerimientos del Sistema

] G- [:l Reguerimientos Funcionales

=- Data Madel

72 Data Modsl
- ] Schemal

Project Browser

EIF‘rDject Browser :@Resnurces ;%Prnperties

Crear una tabla

Para crear una tabla en EA, se debera seleccionar el objeto Table, de la seccion Class de la caja de
herramientas y trasladarla al diagrama.

Una vez creada la tabla el siguiente punto es definir a que tipo de Base de Datos va a pertenecer, ya que
de esta forma se define la lista de los tipos de datos habilitados para la definicién de las columnas.
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B8 Class : Table2

I ame: | Inventario |
Stereatype: |ta|:ule b Ilg.-’-'-.lgstran:t ol
Aythor: e | Status: Enpnsed |
Soope: Public s | Complesity | Easy w
Alias: Database: | ffee
Persiztence " I Kepwards; |
— ; i —_—
Phasze: 1.0 | Wersion: 1.0 |
Motes:
apply ] [ ak. ] [ LCancel ] [ Help ]

Otra propiedad importante que se ha de asignar a una tabla es la propiedad Owner. Esta propiedad se ha
de asignar a través de los Tagged Values, para ello del menu de la herramienta, se debera seleccionar View->
Tagged Values y seleccionar el objeto al que se le quiere asignar los nuevos valores. A continuacién
seleccionar el icono New Tag y asignar la propiedad.
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© File Edt Wiew Project Diagram Element Tools  Add-Ins  Settings  ‘Window  Help

DEd B2B- DS Y. BEc d Ha ADA . o - owkc  OBABE B o
_8: | Logical Diagran: "Schemal” createdt 11/01/2006 modfied: 11/01/2008 100% 827 « 1163 x  |Tagged Values ¥ Rx
g - )
Table
In\.re:tario = T
] o
|
— || Inwentario [Class]
iResources E%Tagged Val...JD@Properties
Tagged Value _' | v i x
Tag: tiner v| J
Walue: || =
=
[ 0Ok ] [ Lancel ] [ Help ]
X:
B — 3 2
1 Start Page\ *5chemal J 2 iPan & Zoom @Notas
Py A N1 2 < A | Defauk Style - R ER | @aaqal s %"X@

395 % Top: Z02-

Class Inventario L&ft:

Crear Columnas

A continuacién ya se pueden definir las columnas que van a formar parte de la tabla, para ello se ha de
seleccionar la tabla a la que se quieren anadir las columnas y a través del botén derecho del ratén seleccionar la
opcién Attributes.
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BS Inventario Columns

EJie

Leneral IDetaiI [ Corstraints |

Mame: | |
Data Type: o | [ 1 Primary Key
[T Mot Mull
Stereotppe; | column w | []Unique
[riitial; Ealunn Properties
Aooess: Public v Alias:
Mates:
Colurins _—‘E_J __“I*A_J New 23YE Delete
Fr. . Mame Type Mot Jnique
Cloze ] [ Help
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Si el campo Data Type se muestra vacio, quiere decir que no se ha seleccionado en la definicién de la
tabla que tipo de base de datos va a pertenecer. Existen algunos tipos de datos, como el NUMBER en Oracle,
que requieren precision y escala. Estos campos se muestran por pantalla una vez seleccionado el tipo de dato

que lo necesita.
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BS Inventario Columns

' General |Detail | Comstraints |

Mame; |
Data Type: | INNIFTISE | [ Primary Key
Precizion: 8—| sz_ [T Hat Mul
Stereotppe; | column w | []Unique
[riitial; Ealunn Properties:
Aooess: Public » | Alias:
Mates:
Columnz _:i;J __?_I New Save Delete
Fr. . Mame Type Mat ... Jnique

Close ] [ Help

Para crear una nueva columna, bastara con introducir el nombre y el tipo de dato de la misma, y pulsar el
boton Save
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BS Inventario Attributes: Nombre

EJie

Mame; Norbre

Data Twpe: |WARCHARZ w | [ 1 Primary Key
Length: R0 | Mt Mull
Stereotppe; | column v | []Unique

[Eu:ulumn Properties. .. ]

Mombre

YARCHARZ  Yes Ma

[ritial:
Access: Public w | plias i
M otes;
Colurmnz ﬁ 5 J Mew Save
Fr. . Mame Type Mat ... Jnique

Close ] [

Help

Clave Primaria

Para la definicién de una clave primaria en el caso en que consista en una Unica columna se ha de

Eusko Jaurlaritzaren Informatika Elkartea
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marcar la opcién Primary Key, de la columna correspondiente, en la ventana de gestion de columnas.

Automaticamente, se genera una operacion que define la clave primaria para la tabla. Para eliminar la
clave primaria definida, bastara con eliminar la operacién creada.

Inwentario

wialumnm
Pl Nombre: WARCHARZ(S0)

wF ko
+ FlE_lnventariol ARCHARZ)

Para definir una clave primaria compleja:
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1. Seleccionada la tabla, con el botdn derecho del ratén se debera seleccionar la opcion Operations.
2. Seleccionar la operacion Primary Key (“PK_" en el campo Stereotype) y guardar. Lo que generara
una entrada en la lista de operaciones con el nombre introducido en el campo Name.

&' Inventario Operation: Inventario

[reeentanio

Public

General ! Behavior | Columng | Pre | Post |

M arne: | [rentario |

Sterentype: |F'K W ! [ Extended Properties. . ]

Accezs |F'u|:||i|: v| .-'f-.lias:| |

Mates:

Operations _@_]E_I Hew 2avE
Hame Sterentype Scope

l

LCloze

||

Help

3. Una vez guardado, se ha de seleccionar la operacion y activar la pestafia columnas
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i Inventario Operation: Inventario

| General |. Eehaviu:ur| Calumnz | Pre | Post |

Colurnr Mame;

I ¥

Caid ||".:|||:.
Irwealved Colummms ﬂJ 5 ] Hew SR =R

Calurmn

[ LCloze J[ Help

4. Del campo Column Name, se ha de seleccionar cada campo de la tabla que vaya a formar parte de
la clave primaria y afiadirlo pulsando el botén Save.
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i Inventario Operation: Inventario

| General !. Eehaviu:ur| Calumnz | Pre | Post |

Colurnr Mame;

Fipeli] i)

Irvalved Calumng QJ 5] [ New H Save ] Ligleta

Coalurmn

Mambre

[ LCloze ] [ Help

5. Con los botones Up/Down, se puede modificar el orden de las columnas en la clave primaria

Inwertaric

w0 L
P Nombre: WARCHARZ(SO)
FRE Apellido: WARCHARZED)

wP K
+ InventarioWARCHARZ, WARCHARZ)
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Claves Externas

EJie

Para crear claves externas se han de seguir los siguientes pasos:
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1. Latabla origen debera tener definidas las columnas que forman la clave primaria de la tabla a la que

se va a conectar.

2. De la caja de herramientas seleccionar el conector Associate

3. Seleccionar la tabla que contendra la clave externa y conectarla con la tabla destino.

Inwentario

woolumns
FRE Mombre: WARCHARZSD)
FRE Apellido: WARCHARZSD)

wP K
+  ImventariolARCHARZ, WARCHARZ)

Empresa

w0l Umn e

"PK idEmpresa; LONG

wP K

+ Fl_EmpresalLOMG)

4. Seleccionar el conector que une ambas tablas y del menu del botdn derecho del ratén seleccionar la

opcion Foreign Keys

5. Seleccionar las columnas que formaran parte de la relacion en la clave externa y pulsar el botén

Save. Debera existir en al tabla en la que se creara la clave externa un campo con el que poder

asociar la clave primaria de la otra t6abla.
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Foreign Key Constraint

Mame F¥_lrventanio_Empreza

Source: |nventario Target:  Empresza
K.ey Calurnn Type Fey Colurmn Type
PE. Mombre YARCHARZ PF. idE mpresa LOMG
Pk Apellido WARCHARZ

idEmpreza_... LOMG

Referential Integrity

: L Save Dielete
Ualete Lascads
4| ¥ 4| 8]
L olurn Type Column Type
idE mpresza_FE. LONG idE mpresa LOMG
& i | | | ’ | |
Lok [ Cancel ]
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EJie

7. Se generaran las entradas de la clave externa y finalmente bastara con pulsar el botén OK.

Imventario

woolUmnm

PR Nombre: WARCHARZGD)
Pl Apellide: WARCHARZSD)
Fl. idEmpresa_Flk: LOMNG

wF K

wP Kn

+ Fk_Inventario_EmpresalLOMG)

+ ImrentariolWARCHARZ, WARCHARZ)

3.8.2. Importar desde BD

Para la importacion de tablas y procedimientos almacenados de base de datos via ODBC se ha de

(idEmpresa_FK = idEmpresa) +
2o

— " uFKn

+FFK_lmventario_Empresa
B —"

0=

+FPHK_Empresa

Empresa

woealumn
"PK idEmpresa: LONG

ﬂ w P Ka

FPk_EmpresalLOMG)

seleccionar el paquete en el que se realizara la importacion. A través del boton derecho del raton y

seleccionando del menu emergente la opcién Code Engineering -> Import DB schema from ODBC, se

mostrara un cuadro de dialogo que nos permitira establecer la conexion a base de datos.
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Import DB schema from ODBC source

EJie

D atabaze Mame: |

i

Filter
Schemas/Owner | |

[ ]Include System Tables
[ ] Inelude User Stored Procedures
[ Inelude User Wiews

Synchronization

(%) Synchronize existing claszes
[] Synehronize Table/Column Comments
[ 1 5ynchronize Column Default Yalues

[ ] Synchronize Check Constraints
() Import as Mew objects

[rport Ta...

Irnpirt

Cloze

Help
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Se debera seleccionar el datasource a utilizar para la importacion, por lo que se debera tener

configurado con anterioridad un datasource en el sistema.

61/178



- Eusko Jaurlaritzaren Informatika Elkartea
I Sociedad Informatica del Gobierno Vasco

Seleccionar origen de datos

Origen de datos de aru:hivu:; : Origen de datos de equipo [

Mombre del arigen de datos ~ Tipo D escripcidn
dBASE Files Uzuaria

Ewcel Filesz Uzuario

M5 Accessz Database Uzuario
i Uzuario  conexion prueba
#f3a.world Uzuano  prueba

Huewvo...

IIn origen de datoz de equipo ez especifico de éste v ho 22 puede compartir, Loz
origenes de datos de uzuano son z0lo para un usuano de este equipo. Loz
arigenes de datoz de siztema lo: pueden utilizar tados laz wzuarnios de este equipo
o un zervicio general del mizmo.

Aceptar ] [ Eancelar] [ Ayuda

Una vez seleccionado el datasource, a continuacion se presentara una relacion de tablas y
procedimientos almacenados presentes en la base de datos seleccionada. De la lista que se presenta se
deberan seleccionar aquellos elementos que se vayan a importar al diagrama.
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Select Tables to Import

EJie

Ay allable Objects Select All

] [ Select None ]

TABLE: MGMT_JOB_STEP_PARAMS

TABLE: MGMT_JOB_STEP_TARGETS
TABLE: MGMT_JOB_SUBST_PARAMS
TABLE: MGMT_JOE_TARGET

TABLE: MGMT_JOB_TPE_DISPLAY_IMNFO
TABLE: MGMT_JOB_TwPE_DISPLAY_PARAM
TABLE: MGMT_JOB_TvPE_IMFO

TABLE: MGMT_JOB_TvPE_URI_INFO
T&BLE: MGMT_JOB_USER_PARAMS

TABLE: MGMT_JOB_VALUE_PARAMS
TABLE: MGMT_LATEST

TABLE: MGMT_LATEST_S0GL

TABLE: MGMT_LICEMNSABLE_TARGET_TYPES
TABLE: MGMT_LICEMNSE_DEFIMITIOMS
TABLE: MGMT_LICEMSES

TABLE: MGMT_LOGIM_ASSISTANTS

TABLE: MGMT_LOMG_TEXT

TABLE: MGMT_MASTER_AGENT

TABLE: MGMT_MASTER_CHAMGED_CaALLBACK
TABLE: MGMT_METADATA _SETS

TABLE: MGMT_METRIC_COLLECTIONS
TABLE: MGMT_METRIC_COLLECTIOMNS_REP
TABLE: MGMT_METRIC_DEPEWNDEMNCY

TABLE: MGMT_METRIC_DEPEMDEMCY_DEF
TARIF- MGMT METRIC MEPFROERNMY METAN S

=)

| OK

| [ Cancel
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Una vez seleccionadas las tablas y los procedimientos almacenados a importar en el diagrama, bastara
con pulsar el botéon OK, y Enterprise Architect se encargara de cargar en el diagrama las tablas con sus campos
y relaciones correspondientes. En el caso de los procedimientos almacenados se mostrara una clase con el
nombre de la base de datos importada y cada operacion de la clase se correspondera con cada procedimiento

almacenado importado
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1
TZ3A0ETO0 El 2941 2T00
s UM szalUrmins
*AK PRODUCTIO: “WARCHARZD *pK SUPPID: NUMBER(E)
*FK CATEGORY: WARCHARICID) NAME: VAR CHARIED)
HAWE: R CHARZEN) * STATUS: “WARCHARICH)
DESCH: “WARCHARIIISE ADOR1: “ARCHARZ(EO
ADDRT: WARCHARIED
Pk CITY: WiR CHARZCED) TEaA04TON
+  PK_PRODUCTMARCHARZ) STATE: “waRCHARZED) [+PK_SUPFLIER E
windexs ZIF: AR CHARZE) 1 wxolumnz
+ T2OA0BI0I0ARCHART) PHONE: “ARCHARZ(ED TAK ITEMID: “ARCHARIOD
+  TIOADBIDEMWER CHARD) (SUPPLIER = SUFPID) *FE PRODUCTID: WaRCHARICID
oF K Pk LISTPRICE: HUMBER{10,2)
FE PROOUCT 1AERCHARS +  PK_SUPPLIER{NUMBER LUMNITCOST: NURBER(I0,2)
s H,_ L2 ) HRITBMZ [ b cUpPLIER: NUMBER(E)
1

oF STATUS: WeRCHARZ
ATTR1: S8R CHARE0
ATTRE: “ARCHARZED
= ATTRI: “8RCHARE0
{PRODUCTID = PRODUCTIOY ATTRA: WARCHARZGD)

ATTRE: “WARCHARZED)

+PK_PRODUCT

wP Ko
+FE_ITEW 1|+ PE_ITBAMARCHART)

0. windexs
T+ TeAD4IDIOVMARCHARZ)

wF Ko
+  FE_ITBM 2(HUMBER)
+  FE_ITBM_1I0SRCHARZ)

4 Anexo 1: Diagrama de Caso de Uso

El presente ejercicio consta de dos partes:
e Creacion de un diagrama con los siguientes elementos:

o Administrador-> Persona encargada del mantenimiento de los usuarios en el sistema.
o Alta de Usuarios -> Caso de uso que implementa la operacion de alta usuarios en el

sistema.
o Baja de Usuarios -> Caso de uso que implementa la operacion de baja de usuarios en el

sistema.

e Disefio de una plantilla para la generacién de la documentacion correspondiente de los casos de
uso. En el documento final se debera presentar la siguiente informacién:

o El nombre del paquete como titulo.
o Cada uno de los elementos que forman parte del diagrama con su correspondiente

descripcion
o Imagen del diagrama.

41 Resoluciéon

64/178



- Eusko Jaurlaritzaren Informatika Elkartea
I Sociedad Informatica del Gobierno Vasco

Para la creacion de un diagrama de caso de uso, el primer paso consiste en la creacion del paquete
donde ubicar el diagrama.

Create New View

M arme
|Easu:| de Usd

Set Yiew lcon Shle
() Simple
(%) Use Case Cancel

() Dynamic
) Clazs View

() Companent

) Deployment

[
s

Una vez creado el paquete el siguiente paso es la creacion de un diagrama de caso de uso en el que
implementar el disefo.

65/178



- Eusko Jaurlaritzaren Informatika Elkartea
l Sociedad Informatica del Gobierno Vasco

X]

| [.-“-‘-.ut-:u]

Select Fron; | Diagram Tppes:
@ ML Structural 82 UseCase
(2 UML Behaviaral Fa Aclivity
ﬂfj Extended (52 State Machine
ES Communication
= Sequence
Tirnitg

[nteraction Oweriew

ML Uze Caze Diagrams capture the behavioral
requirements of a system Lzing use case elements,
and their interaction with participant actorz,

] ][ LCancel ][ Help

Creado el diagrama, se van incorporando los objetos que intervienen en el mismo, inicialmente se agrega
al diagrama el actor.
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85 Actor : Actori

General | Fiequire | Constraints | Link |I Scenarno | Files |

I ame: |.-’-'-.dministrau:h::r |
Stereatype: | b Ilg.-’-'-.lgstract ol
Aythor: % | Status W‘
Scope; Public s | Complesity: | Easy w
Alias; Language: | cnones il
Kewwords: |
Phaze: |E Werzion: E|
Motes:

Ferzona encargada del mantenimiento de los usuarioz en el sigtema

Apply JE Ok J[ Eancel J[ Help ]

A continuacién se agrega el premier caso de uso
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@ Prusha GBB - EA
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Use Case Diagram:Caso de Uso AR NUM-SCEL
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B UseCase : Use Casel

General | Require | Caonstraints | Link !I Scenano | Files |

I ame: |.-’-'-.Ita Ilzuarios |
Stereatype: | b Ilg.-’-'-.lgstract ol
Aythor: e | Status: Proposed bl
Scope; Public s | Complesity: | Easy w
Alias; Language: | ¢nones il
Kewwords: |
Fhaze: |-1_I2I_i Wersion: £|
Motes:

Cazo de uszo que implementa la operacion de dar de alta usuarioz en el
siztemal

Apply ] [ ok ][ LCancel ][ Help ]

Para el siguiente caso de uso, se ha de repetir el mismo proceso, disponiendo finalmente de un diagrama
con el siguiente aspecto
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Use Case Diagram:Caso de Uso

FIMUM S

Finalmente queda por asociar los casos de uso al actor
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© Prueba_GBB - EA
: Fle Edit Wew Project Diagram Element Tools  Add-Ins  Settings  Window  Help
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Use Case Diagram: Caso de Uso AR MUM SCE

Llegados a este punto, se dispone de un diagrama en el que los elementos se encuentran informados,
por lo que se procede al generacion de la plantilla para explotar los datos. Para ello se abre el generador de
documentacién RTF
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EJie
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Use Caze Diagram: "Caso de Usa" created: 20/09/2007 16:51:07 modfied: 20/09/2007 16:58:27 100% 795x1130
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= [ Madel
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A o @ Alta Usuarios
e - & Baja Usuarios
Generate RTF Documentation
Administradar - Foagt Package: |
Outputtofie: | DADATOSMCOODBOBCMis documentostintervisws. TF (]
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vax
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A continuacién, se accede al mantenimiento de plantillas y se da de alta una nueva:
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&Prusha GBA - EA

¢ Fle Edit  iew Project

Diagram  Element Tools Add-Ins  Sethings ‘wWindow Help

DEE LB RDS BS. BB B Ba DDA A

8?| Use Case Diagram: "Casa de Usa" created: 20/09/2007 16:51:07 modified: 20/09/2007 16:58:27 100% 795 %1130
z .
RTF Templates B
Casode Uso
Defined Templates 22 Casodelso
2 Administrador
& Alka Usuarios
S Baja Usuarios
Jikos del Sistema
~Adraini=tr] Floot Pac
Output to |B
RTFD [ Import From Reference File ]
Usze Termpree: T
New Document Template Lirces i%Tagged val.., |°@Prnperties
Mew template: |
Copy template: |None v| j
0
i ak. i [ Lancel } [ Help J
Progress:
| L ]
4 “Start Pag'é‘\\ *Caso de Uso I I ‘pan & Zoom @Notas
P A [T S8R Defaul sty s fopiidFahh A RA8QQ RES XL
Ready

AR NUMESCRL
Una vez creada la plantilla, automaticamente se abrira el editor de plantillas vacié
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Sections

M ﬂ Content
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EJie

=[] Modsl

=

HER|s=@alo o~ |M|eddd|@ o

£
=
=1

[ Gloszary
[ lssues

‘ Iormal

|| il [0

[ Tasks

P &

= [[] Package Element

- [[] Requirement

- [[] Extemal Requirements
-[] Canstraint

-[[] Tagged Value
-[[] 5eenaio
[IFik

[ Test

-[[] Change

-[] Defect

[ lssue

[ Task

Rk

-[[] Effort

[ Metic

-[[] Resouce
-[[]Modsl Document
=[] Diagram
-[C]Element

-[] Cannectar
[ Messages

=[] Element

- [[] Requirement
-[[] Estemal Requirements
- [] Canstraint

~[[] Extension Paints
-[[] T agged Value

|l
L
|~

v|B I

uAlE

TR

ma

fagged val.., | D%Properties

> ax

=
9

[Page:1 Line:d Col:1
|

e
=

e

StatPage,  *Casodelso |

bl

=
b i @) Pan i Zaom @Notes

R

&l\ S W= st |_DEFauItSter

Lhlema @aaac & 3‘-’:-:@

Ready

AR NUM SR

Para agregar el nombre del paquete , se debera seleccionar del apartado Sections el check Package,
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& Casos de Uso
Fle Edit W¥iew Insert Font Paragraph  Table Other Help

Sections Content

- Mol A HER| ER[o o |A|n T oxes
o [ Glaszany '
' E-|:|Issu.3g |Nurmal VHArlaI vl|1lil v| B I O AH;E
[ Tasks
= [#] Package
|_| |:| Package Element
. [ Requirerment
f [] External Requirements —
- [[] Constraint
- [] Tagged ¥alue
[ Scenaiin
 [Fie
[ Test

: package =Y
: th?ngte .insertsPackagescontentshere. f]
: elec

: =package
S saue

~[OTask
- [PRisk
- [] Effart
- [ Metic
- [] Resource
- [] Model Document
|_| |:| Element
. [ Requirerment
f [] Extemnal Requirements

[ Constraint NS 'Page:1  Line:2  Col: 34

] EHtensu:un F'u:unts v ¢ m [

| <

|1

Para obtener el nombre del paquete, en la seccién delimitado por los tags seleccionar la propiedad Name
que se muestra con el botén derecho del raton:
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@) Casos de Uso Abstract
File Edit View Insert Font Paragraph Table Other Help Alias

Date Created
Sections ﬁ | @ | Content
Date Created {Short)
»

Y D..Edélossary =] HSR| L 2B e vt | @ [100% v]|
- [lssues |Wermai || ari Date Modiied (Shart) |7 U A |

o[ Tasks Flags
& B Fackoe I ¢ . R R Y |
- [[] Requirement IsContralled
[ Estemal Requirements | IsProtected
- [] Canstiaint -
- [[] Tagged Value Mame |
-~ [[]Scenario Nates
- [JFile
[ Test =
. Ethange %‘“k Phase
[ Defect N Scope
- []lssue 1
[ Task <pal
[ Risk Stereatype
- [ Effot SteretypeE:x
[ Metric _ —
- []Resource Harson
“[]Model Document walusOf
=[] Element
- [[] Requirement
[ Etemal Requiements  —
- [] Canstiaint
- []Extension Points
-+ [[]Tagged Yalue
- [[] Custom Property
[ Seenario
- []File
[ Test
- [[] Change
[ Defect
~[Clssue
[ Task
- [[]Risk.
- []Effort
[ Metric
-~ [[]Resource
[ Transition
=T Connentar

[

Parent Package

Status

E

NS [Page:1  Line:3 cal 1

.4
(=
e

Para agregar los elementos que forman parte del diagrama, se ha de activar el check Elemet
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= [¥] Package
=[] Package Element
=[] Requirement
- [] Estemnal Requiements
- [[] Constraint
[ Tagged Yalue
- [] Seenario
JFie
[ Test
- [[] Change
- [] Defect
- Olssue
[ Task
- [JRisk
[ Efar
[ Metic
~[]Resource
- [] Model Dacument
=[] Diagram
- [[] Cannector
- []Element
o [Messages
- [¥] Element
- [[JRequirement
[] Estemal Requirements
- [[] Canstraint
[[] Estension Paints
[]Tagged Yalue
- [[] Custam Property
- [] Seenaro
- [JFie
[ Test
- []Change
- [] Defect
- Olssue
~[OTask
«[JRisk
[ Effort
[ Metric
- [Resource
[ Trangition
= [ Crnnentar

ol

=

A continuacién se han de agregar las propiedades Name y Notes.

HBER|:2@|o || ada|E | mex

>

|Norma\

b || Arial

~|[10

¥ BIUA]

package =T

1
{Pkg.Name}y

element=1
_insert-Element=content=here.
<-elemen

<~package]

[Page:1

Line: &

Cal: 34

e
%
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EJie

File Edt “iew Insert Font Paragraph Table Other Help

Sections

= [¥] Package
[ [] Package Element
- [[] Requirsment

[T] Extemal Requirements

- [] Canstraint

- [] T agged Value

7] Seenario

CJFie

[ Test

[ Change

[] Defect

[ lzsue

Task

] Risk

[T Effort

[ Metric
[] Resource

-+ ] Model Document
=[] Diagram
[ Connector
] Element

: [[]Messages
- [¥] Element

; 7] Requirement
[T External Requirements
[T Constraint
[[] Extension Points
- [] T agged Value
- [] Custom Property
7] Seenario
[ File
[ Test
[[] Change
[] Defect
[ lzsue
Task
[ Risk.

[T Effort
[ Metric
[] Resource
¢ [ Transition
=T Cnnectnr

Al EJ Contertt

I

HESR|:2@|o o |a(maa|m o |
[ Marmal || aral NI __B_|1 UA ||§§ == ; .
I R SRR R RNy |

package>T

1 :

{Pkg.Name}"

element=T

T

[Element.Name}f

[Elemert. Notes)T T

1lelemenﬂl

<packagey
IN5 [Page:1  Line:11  caoli0 v
< i _ b

Y finalmente para que se muestre la imagen del diagrama, se debera activar el check de Diagram y

agregar la propiedad Diagramilmg, de tal forma que la plantilla definitiva sea la que se muestra a continuacion
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= [¥] Package
(=[] Package Element
[ Requirement
- [] Estemnal Requiements
[[] Constraint
[[]Tagged Yalue
[ Seenaria
JFie
[Test
[[] Change
gl
[lssue
[ Task
[JRisk
[ Effart

[ Metric
[[JResource

: [] Madel Dacument
=) [#] Diagram

i [[] Connector
[ Element
o [Messages
- [¥] Element

- [[JRequirement
[] Estemal Requirements
[ Canstraint
[[] Estension Paints
[]Tagged Yalue
[[] Custam Property
[ 5eenaria
[JFie
[ Test
[] Change
[[] Defect
[lssue
[ Task
[ Risk
[ Effort
[ Metric
[[JResource
[ Trangition
= [ Crnnentar

ﬁl ﬂ Contert

]

HBER|:=@|o ~ |8 ada|E | mex

>

|SSElookmark ta ||IAcwda Sans

MIE

o

“’-||FIQA|
e

1|'.fc1|:kage =1
{Pkg.Name}y

diagram-=7

= diagram
element=

<-elemen
<packag

[Page:1  Line:d col: 1

3

|
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El documento final generado presentara el siguiente aspecto:

T interviews.RTF - Microsoft Word

Escriba uma prequnta - _)_(*1.

Caso-de-Usof
1
1

uc Cazo de Uso

Alta Usuzrios

Administrador T~

Baja Usuarios

1

T
Administradory
Persona-encargada-del- mant enimient o-de-los usuarios-en- el sistemaf

T
Alta-UsuariosT
Cazo-de-uso-que implementa: la- operacion: de- dar-de-alts uzsuarios-en- el sistema g

1

Baja-Usuariosy
Cazo-de-uso-que implementa: la- operacion: de- dar-de-baja- uzuariozen- el-sistema

1

Il
A 25 Ln 1 Col 1 GRE| MCA [EAT) S0E| Ingles (Esta @

2eElL L
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5 Enterprise Architect VS Arin Bide

En el siguiente apartado se va a definir el proceso de creacion de la documentacion correpondiente a
Arin Bide a partir de la herramienta Enterprise Architect.

Para ello se proporcionara un esqueleto de proyecto, que se ha de rellenar con los datos especificos de
cada proyecto, asi mismo se proporcionaran las plantillas necesarias para la generacién de la documentacion
final.

5.1 Arquitectura Proyecto

La arquitectura que todo proyecto de EA presentara en su fase de creacion es la siguiente:

BB d B 4P
= [@ Disefio
[+ Modula Funcional

Requerimientas Del Siskema
[#] Casos de Uso
Ciagrama de Clases
Arquitectura Siskema
Construccion Sistema
Disefio Fisico Datos
Migracion v Carga Inicial Datos
Plan de Prusbas
Entidades Implicadas

s W O e VO e WO e OO DO IO e O

EIF‘rDjEu:I: Erowser @Resnurces

Con dicha estructura se cubre la creacién de los distintos documentos que completan la documentacion
de Arin Bide.

NOTA: La secciéon Entidades Implicadas recoge todas las clases de la aplicacion que intervienen
en el desarrollo con sus métodos y atributos.

5.2 Documentacion

Dentro del proyecto “Oficina Técnica de Calidad y Pruebas” iniciado por el Area de Asistencia Técnica, y
concretamente por el equipo de Consultorias de Areas del Conocimiento, se han definido un conjunto de
herramientas que dan soporte al modelo de calidad de software que ha definido el propio proyecto.

Una de estas herramientas es Enterprise Architect (en adelante EA).

Con objeto de facilitar su uso, se ha creado un proyecto de EA de ejemplo, que permite generar la
documentacion de la metodologia ArinBide a medida que se realiza el analisis y disefio del sistema.

Si se opta por ese ejemplo, puede consultarse el documento OTC-Herramientas-Guia de uso del ejemplo de
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EA.doc Puede descargarse desde https://ataria.ejie.eus/docs/DocView.aspx?DocumentiD={a41be76e-048f-4f58-
a85a-d705082f1a65}

5.2.1.Documentacién en EA

En la arquitectura estandar que se proporciona, una vez creado el repositorio se presentan las plantillas
necesarias para la generacion de la documentacion.

En la pestafa de Resources, en el apartado correspondiente a Documents -> RTF Documents, se han
creado una serie de accesos directos para la generacion automatica de la documentacion, de tal forma que se
asocia la plantilla correspondiente con la informacion que se desea crear.

Resources x

= ﬁ Resources

ﬁ MO Technologies

(551 UML Profiles
] UML Patterns
] Templaktes
= @ Dacurments

= [Z] RTF Dacuments
8511 _Modula_Funcional

8351_2_Indice_Requisitos
8351_3_Detalle_Requisitos
851 4 Casos_Uso
DaI_1_1_ Sistema
DaI_1_2 Sopoarke
DaI_1_ 3 Fequisitos
DaI_1_4 MNormas
D3I_1_5_Entorno
D3I_10_1_Entorno_Pruebas
D3I_10_2 Plan_Pruebas
D3aI_3_1_ Requisitos_Lsuario
DaI_3_2 Agrupacion_Caso_Lso
DaI_3_3_Casos_|lso
DaI_3_Agrupacion
D3aI_3_Caso_lso
D3aI_3_Usuarios
D3I_4_1_Diagrama_Clases
D3l _4_7 Clases
D03I_6_1_Disefio_Datos
DaI_6_2_ Caminos_AcCceso
DaI_&_1_ Consktruccion_Sistema
D3I 9 1 Migracion
03I_9_7 Plan_Prusbas
ﬂ Matrix Profiles
Favarites
Stylesheets

-+

L

EIF‘N::... @Re... F‘a... D%F‘rl:u... I:%T-Eh... &Nl:utes Testing
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Para generar el fichero fisico correspondiente a una determinada fase, se deberan seleccionar aquellos
accesos directos que formen parte de dicha documentacion y ejecutar la opcion Auto Generate Document, que
se muestra al pulsar el boton derecho del ratén

Resources =

= q’ Resources

-

EIPH::... @Re... F‘a... c%F‘ru:u... c‘%Ta... &Ncutes Tesking

ﬁ MDG Technologies
[ uML Profiles

LML Patterns
Templates

@ Documents

=] RTF Documents

Cpen Document. ..

Generate Document. ..

Delete Document

Aubo Generate Document. ..

DSI_]. P i L B [ LR
DsI_1_4_Mormas
D5I_1_5_Entorno

D5I_10_1 Enktorno_Prusbas
D5I_10_2 Plan_Prushbas
DsI_3_1_ Requisitos_Llsuario
DsI_3_2_Agrupacion_Caso_llso
0SI_3_3_Casos_lUso
[SI_3_Agrupacion
Dsl_3_Caso_llso
DsI_3_Usuarios
D5I_4_1_Diagrama_cClases

D51 4 2 Clases
D3I_A_1_Disefio_Datos
DSI_6_2_ Caminos_Acceso
0SI_&_1_Conskruccion_Siskema
DsI_9_1_Migracion

D3I_9_Z Plan_Pruebas

&) Matrix Profiles
Favaorites
Shylesheets

Esta opcién ejecutara la generacion automatica del documento y presentara el resultado del mismo por

pantalla.

Para la generacién de la documentacion se identificara que documento es el que se desea generar y se
ejecutaran los distintos accesos preparados para dicha generacion. De tal forma que si se desea generar la
documentacién correspondiente al ASI, se deberan ejecutar todos los accesos que comiencen por ASI.

84/178



- Eusko Jaurlaritzaren Informatika Elkartea
I Sociedad Informatica del Gobierno Vasco

DOCUMENTO ACCESOs
ASI- ASI 1 Modulo Funcional
ASI 2 Indice Requisitos
ASI 3 Detalle Requisitos
ASI 4 Casos Uso

Nota: Cabe destacar que el nombre de las plantillas coincide con el nombre de los accesos
directos preparados para la generacion de la documentacion

5.2.2.Documentaciéon Arin Bide

Una vez ejecutados los accesos desde la herramienta, la ubicacion fisica de los documentos generados
es la siguiente:

e C:\UML\Documentos\

o ASI\Docs
o DSIM\Docs
(@ -

De tal forma que en la carpeta Docs, se guardan los documentos intermedios que forma parte del
documento definitivo.

® C:\UML\Documentos\ASI\Docs E“E|E|
archivo  Edicion  %er  Favoritos  Herramientas  Awuda 4 ,’ 4
- — [
- . i 1 ¥ ' [ :
. @ Akras 2 I? 7 Busqueda ||L-__ Carpetas
- Direceidn || C:UMLYDocumentos| ST Docs v| Ir
Carpetas b4 iﬂl’].ﬁ.SI_l_Mndulu:u_Funciu:unaI.rtf

& MasT_2_Indice_Requisitos it
= W45 3_Detalle_Requisitos.rtf
i'.—r'lj.ﬁ.SIj_Casus_Usu.rtF

= () umL
= |3 Documentos

|5) Does
= |3 D513
I0) Does
= [5) Dals
L'"i’] Docs
= 7 Dsls
u:I Docs
= ) Dsls
I5) Does
= | D519
I7) Does
[C7) Dal10
Ifi’] Docs w
4 pbjetn. Espacio disponible en disco! 409 MB 408 KB '_-J M PC

[
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Una vez generados los documentos intermedios, se procedera a su unificaciéon en un documento final,
para ello en cada carpeta principal (ASI, DSI1...) se proporciona una plantilla preparada para la creacion de
dicho documento. En dicha plantilla, se han vinculado los distintos documentos que forman parte del documento
final, por lo que una vez generados dichos documentos, se deberan refrescar los vinculos del documento

principal.

Para ello desde el documento principal, en este caso el ASl.doc, desde el menu Ediciéon-> Vinculos, se
presentan los distintos documentos vinculados y el orden en el que se encuentran.

Vinculos

Archivo de origen; ChGGAST 1 Modulo Funcional.ref
Elemento de archivio; ' chalizacion
Tipo de winculo: Texto [ ] Bloqueada

Cpciones para el vinculo seleccionado

Archivo de arigen: Elemento Tipo Actualizacion
i I_1_Maodu... [ Actualizar ahora ]
(i AASL_2 Indi,,, Texto rar.
[T 8513 Deta,., Texko Man, orige
(o, 85I 4 Caso,., Texko Man.
[ Cambiar arigen. .. J
[ Romper vinculo ]
Informacion de origen para el vinculo seleccionada Metodo de actualizacion para el vinculo seleccionado

[ Aceptar ] [ Cancelar

Para actualizar el documento, se seleccionara de la lista de Archivos de Origen, aquellos documentos

intermedios que han sufrido cambios y se pulsara el boton de Actualizar ahora.

Una vez actualizado el documento con la informacion correspondiente, el ultimo paso consiste en asignar
los estilos de EJIE al documento, para ello se debera ejecutar la macro ActualizarEstilos, desde el menu

Herramientas -> Macro -> Macros
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Mombre dela macro;

ActualizarEstilos

[ Ejecutar ]

AckualizarEstilos

Paso a paso ]

[
[ Maodificar J

[ Crear

[ Eliminar

[ Crganizadar.. .

Macros en: |T|:u:|a5 las plartillas v documentos activos v [ e ]

Descripcion:
[Macrn creada el 01042005 par EJIE

Una vez actualizado el documento con los estilos de EJIE, se debera refrescar el menu del documento.

NOTA -> Se ha de seguir el mismo proceso para la generacién de cualquier documento.

5.3 Andlisis Sistema Informacién (ASI)

5.3.1.Modelado UML

87/178



- Eusko Jaurlaritzaren Informatika Elkartea
I Sociedad Informatica del Gobierno Vasco

Para la generacion del ASI, se han de actualizar de la estructura estandar los siguientes diagramas

e Modulo Funcional
e Requerimientos Sistema
e Casos Uso

Modulo Funcional

La estructura que se proporciona para la creacion del modulo funcional del sistema es la siguiente:

& EJIE_BASICO - FA EE|

© Fle Edt iew Project Diagram Element Tools  Add-Ins  Settings  window  Help

: [l RO E9. BBc & Ma Ab@I .« - Juk- (OB ABE
fI??“?P?F i ll)i Component Diagrarm: “Modulo Funcional”  created: 08/06/2007 10:25:53 modified: 20/04/2008 13:31:24 100% 7951130 x| 't
I I : <
Lo | A BrE-oEd g
Analysis = @Diseﬁo
lUse Case = Modulo Funcional
| : - Modula Funcional
| Class s Requerimientos Del Sistema
S [®] Casos de Uso
I T Diagrama de Clases
| Communication Arquitectura Sistema
Interaction Construccion Sistema
I = = Disefio Fisico Datos
| S Migracion v Carga Inicial Daty
State Plan de Prusbas
Activty Entidades Implicadas
Component
1 Package
{l Component
B Class
| %0 Inkerface
M Object
I:l Part
Deployment -
Cuskom x b
il || L ' 2
| Prafils |14 Start Page L Requerimientos Generales \ Modulo Funcional b
| B | Testing e
3L Schema T 1 O =
| E || Test Status | I
Requirements i
Mainkeriance T i ol i e | |
User Interface 4 4 » M Unit 5 Integratiuon System . Acceptance /4 Scenario ; : EIP..; @R.‘ P.‘ D‘@P.‘ C@T.. &N..
2. A 12 & 7| Defadl style 2 JoplEEl TN e85 080880 % X
7

Diagram: Modulo Funcional

Para creacion del modelado en UML, se deberan seguir los siguientes pasos:

e Agregar tantos componentes en el diagrama como mddulos funcionales principales existan en la
aplicacion.

De la ventana de herramientas se debera arrastrar el objeto Component al diagrama
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@ EJIE_EJEMPLD - EA QE|

. Edit Wew Project Diagram  Element Tools  Add-Ins  Settings  Window  Help

‘D= LS B, B A ey D0 (B, A * Auk- L1 B A B P

{Taalboz: Companent Diagram: "Modula Funcional”  created: 08/06/2007 10:25:53 modiied: 14/04/2002 17:58:24 100% 79541130 » |PrejectBrowser TeR
| = " 5

£ Al BB ciEad B g
Analysis = [iijiseﬁo

s | ] Modulo Funcional

Use Case
| - =8 Modulo Funcional

| Class | - &l Buzon de Entrada
o &l Muevo Sisterna de Datee |

Composite
| T @ @ sistema Programador
| omrniceon Requetimientos Del Sistema
Interaction 3 |E| Casos de Uso
| Tini Sistema BEEOHoEER SR Diagrama de Clases
| Tirning Programador Arquitectura Sistema
State Construccion Sistema
| Ac.éivity Diserio Fisico Datos
t - 3 Migracion v Carga Inicial Dat:
Component Plan de Prusbas
B Package Moz DS:;ma g [ Entidades Implicadas
B Component
B dass
| 2  Interface
B object
o Port
Deployment -
| | w
Cuskom i | » =
Frofile 4 Stark Page\ Moduloe Funcional | I
Metamodel Testing ¥y ox
#ML Schema [ ™ =T - & |
WaDL Test Stats || o | |z
Requirernents
Maintenance B ke FD41E005 _(_ | _>
User Interface o4 M O Unit g \ntegrati"on System 4 &cceptance A Scenario .EIP..;@R.. P.. QQP.. Q@T.. EN..
: : [t % &' 7| Defaul 5ty ad o izt a0l T K
i ETAUIE Shyle J E = =]
Ready

e Por cada Componente - Modulo Funcional agregado, se deberan vincular tantos componentes
como modulos secundarios formen parte del modulo funcional.
Para ello se agrega un diagrama al modulo principal y se agregan tantos componentes como
modulos secundarios existan.
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iagram

I ame: ESiStema Prograrmador | [""\"Ut':']

Tupe

Select From: Diagram Types:
[ UML Stuctural
[ UML Behaviaral
lla[:‘_j Extended

Custom
Requirements
Maintenance

=
T
e

S

Uszer Interface

P

Analpsiz Diagrams are simplified Activity diagrams
uzed to describe high-level buzinesz proceszzes with
lezz LML formality.

[ aF, ][ LCancel ][ Help ]

De tal forma que la estructura final, una vez creados los médulos funcionales correspondientes a

la aplicacion presente la siguiente estructura.
& EJIE_EJEMPLO - EA D@El

: Flle Edit View Project Disgram Element  Tools Add-Ins  Settings  Window  Help

NEH »@B RDS B, PWBe @ hw Ab0 . v Ak |[[1BA
il ¥t Analysis Diagram: “ASistema Programadar” created: 30/08/2007 11:30:47 modiied: 14/04/2008 16:54:08 100% 795: 113 x| s
[ = — ' =
L | A B-B- R
Analysis | @ Disefio
I . : | =~ lo Fui
Act.or id =8 Modulo Funcional
Chiect P & Buzon de Entrada
Process P i Sistema Programador
Callabaration . i 2 asistema Programador
i Afiadir Seccion
Send

Afiadir aviso
Receive Afiadir aviso A == H - & aAfiadir una pagina
@ Requerimientos Del Sistema

1 '._I.
| Use Case || ®= EI Casos de Uso
Class 2 Diagrama de Clases
+ - @ Arguikectura Sisterna
Composite =

E| Canstruccion Sistema

Disefio Fisico Datos

Migracion v Carga Inicial Datos
Plan de Prusbas

Cammunication -
I Affadir Seccian

Interaction

| Timing Entidades Implicadas
Skate
Ackivity
Component
Deployment
F =il :
Cuskan | £ »
| Profile 11 4_ Start: Page\ ASistema Programador ] - b
Metamodel :Testjn'g 'villi?(j
| %ML Schema I ™ WE=T 3 @ |
WSDL | Test Status || Test:
| Reguwrements | Skatus: w Type:l ~
| Maintenance ] Run By: w | CheckedBy: | w | Last Run: “j 2 HES |>
| User Interface (B R Unit Imegraﬁgn System Acceptance A Scenario ‘EIP @R P.‘ E'@P.‘ C@T.. BN..

. e e 2 o7 7| Default Style = S S:' Gt

s 5 M| F ol @8 60| 5
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e En cada modulo agregado al diagrama, el campo Name, se debera informar con el nombre del
modulo funcional y el campo Notes, se debera informar con la descripcion funcional.

& Component : Sistema Programador

General | Fiequire | Constraints | Link | Seenario | Files

M ame: | i |
Stereotype: | R iD.-’-‘-.Qstran:t ]
Author; |» | Status: EDDDSEEI il
Scope: Public T Caomplegity: .EEIS_'H \:|
Alias: Language: | ¢nones W |
Keywords | |
Phaze: |—: ersion; |—| I
Motes:

EEI Lzuarno g podrd generar Avizoz ¥ Post-it para aun dia concreto o &
| peniddicos, par gjemplo todoz los Lunes Tambign podrd reerwviar dvizos,
|Alertaz v Postit a otroz Buzones o enviar Tareas, Svisos, Alertas y

{Postit & otroz buzones.

|EI zizterna Programador permitird al usuano desde cualgquier vertana
| que e muestra en pantalla completa de con la funcidn afadic podré:
EI Afiadir la pagina a trabajos habituales

|| Afiadr la pagina a trabajos recientes

1 Afiadir la pagina como aviso =
| Afiadir un aviso

[ e

gppy | [ ok [ Caneel || Hep

Por ultimo, es importante destacar que todos los diagramas que se creen en esta seccidn deberan
presentar la siguiente estructura.(Seleccionar el diagrama y pulsar la opcion Properties del menu que aparece
el pulsar el botén derecho del ratén)
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EJie

Component Diagram: Modulo Funcional

Highlight Forgign Objects
Show Element Property String
Show Feature Property String

Document Ophions -

Motes:

Show Connector Property String

[ Exclude image from RTF Documents

[ Maintenance

Package Contents

Connectar Motation

Mame: | Modulo Funcional | Page Size

Authar: | gon bh % | Stereotype; | w | |.-’-‘-.4 Sheet, 210- by 297-millimeters

Versian: |1-':| Created: I8/ DB 2007 | . . T
o | Landsoaps -_vann::e

Zoom (100 v | Modfied:  14/04/200817562¢ |

Appearance Options

|lze Stereatype |cans Shaw Page Barder Yizible Compartments Wizible Clazs Members

Show Element Sterectypes [ ] Show Detailz on Diagram Attributes Public

Show Feature Stereotypes Show Felationzhips Operations F'r!:ltEDted

[ ] Use Alias if Available [ ] Shaw Mon-Mavigable Ends [ TE'QS. Private

Show Additional Parents ] Show Sequence Notes [ S Package

Show Visibiliy Indicators Show Collaboration Mumbers [] CDngtramts Property Methods

[] Show T able Dwrer [ Testing

Shiowy Parameter Detail:

i Tupe Only

LML 2.1

[] Document each contained element in RTF

[ Set Lapout Style ]

J |

[ Apply

][ Cancel H Help
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Requerimientos del Sistema

La estructura que se proporciona para la creacion de los requerimientos del sistema es la siguiente:

& EJIE_BASICO - EA (=T

© File Edt ‘iew Project Diagram  Element Tools Add-Ins  Settings  Window Help
L0 D& B&. B & e a0 . A ik ~
;'ngll_:p_)_c_ Requirements Diagram: "Requerimientos Generales” created: 04/09/2007 9:43:26 modified: 01/04/2008 20:16:14 100% 79 % § i

4 vl A B 8- leEE

Analysis Sistema = @ Disefio

Modula Funcional

Use Case
I Requetimiertos Del Sistema ||

| Class | [ E R R =quermiertos Gerir:
i [:l Requerimientos Funcion| |

Composite
I i G [:] Requerimientos Mo Fung
Communication i - [ sistema
Interaction Requerimiertos Funcionales #- [@] Casos de Uso
I T' 1 _ Diagrama de Clases
| Arquitectura Sistema
State Construccion Sistema
Activity Dl.seno. Fisico Datos 3
I = Migracion v Carga Inicial Daty
| Component Flan de Prusbas
Deployment | Entidades Implicadas
Custom
Profile
Metamodel
I Requeri miertos Mo Funcionzles
#ML Schema
WSOL
Requirernents
[ ¥
B Package < . | >
[E  Requirement Iq Start: Page\ Requerimientos Generales I
= Feature |
= | Testing » 0 X
Ohbject , § (G 2 )
| S5O
A Aaggregation — {
/' Inheritance Test il s | e
Mairkenarice indl A ] e el e | | >
User Interface W4 » p W Unit /4 Integration System 4 Acceptance / Scenario EIP‘.; @R.. P.. D@P.. D@T.. &N..
= r 1% 57 7| Default tyle e . e 2| 20 44 B W | ;e A @O @ 8 Q| %;H g .
)

Requerimientos Generales

Definidos los distintos tipos de requerimientos del sistema, el siguiente paso es agregar cada uno de los
requerimientos en el tipo correspondiente. Para ello se debera seleccionar el tipo de requerimiento en el que se
quiere agregar un nuevo elemento y del menu emergente del boton derecho del raton seleccionar la opcion Add
-> Add Element
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@ Prueha_GBB - EA B@@

: Fle Edit Wew Project Diagram Element Tools  Add-Ins  Settings  Window  Help
DEE B0 RDS BO. BB & e AGR . A - Auk~ OB AB
Fequirements Diagram: “Requenimientos del Sistema’" created: 19/09/2007 16:01:31 modified: 19/08/2007 16:05:50 100% 79 x|
A BB c R
=

Model

xoojbo L |

B- Requetimientos del Sistema
- B Requerimiertos del Sistema

Properties...

Package Control 3

Add Diagram... | Add 3

Requeri miertos Funcionales

#idd Element... M | S :

0 | 52

Add Package... Chrl+wy
e ! Code Enginesring 3

Add Madel using ‘Wizard. .. Build and Run 3

ImportfExport 3

Transform Current Package ChrHMayusculas+H

T Contents 4
Bookmatks

E Eﬁ Search in Project Brawser, . Chrl+Mayusculas+F
Copy Mode Path ta Clipboard

Save Package as UML Profile

l® |

@ Mave up
B Move down

¥ Delete Requerimientos Funcionales'

@ Help...

b

< | ¥
4 ‘StartPage™,  *Requerimientos del Sistema | Requerimientos Fundonales | b | @panzzoom | Bctes
2 4" 7| pefaul style - J- o o ao] oo AL Ba Bo | o B AL | @) @ | G

Insert a new element in tree SR ¢ S

A continuacién se mostrara una ventana con las siguientes opciones:
= Type: Tipo del elemento a agregar

= Name: Nombre del elemento.
= Stereotype: Estereotipo del elemento a afadir.
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Tvpe: | Fequirement v|
Mame: |Hequerimientn 1 | [&utu]
Stereotype: | w |
Open Properties Dialog on Creation
Cloze dialog on OF
[ lieadd to Current Diagrar
[ ok ] [ Cancel ] [ Help ]

Por defecto, el campo Stereotype tiene el valor Functional. Se puede introducir un estereotipo particular
que la herramienta es capaz de almacenar para la siguiente operacion.

Finalmente el diagrama de requerimientos quedara tal y como se muestra a continuacion:

® Prueba_GBB - EA CEEX

© FEle Edit ‘iew Project Diagram Element Tools  Add-Ins  Settings  Window  Help

N e D8 B, AW @ Hep a0 0w

g Requirements Diagram: "Requermientos del Sistema”  created: 13/03/2007 16:01:31 modified: 13/03/2007 16:15:47 100% 73 x § I
g | :\
Reguerimientos del Sistema
- g Requerimientos del Sistema
=- Fequerimientos Funcionales
-z Requerimientos Funcionales
- = Requerimiento 1
Requeri miertos Funcionales
= + Requerimienta 1
_Eprnject Browser @Rasnurces '%@Prnperties
Pan & Zoom S
eae8q ———
—
s

& S =1l | k2
|4 ‘StartPage™,  Requerimientos del Sistema Requerimiertos Funcionales | b ﬂPan&Znnm [ 1 rtes
2 _,:’_ < ot __g""' Diefault Style - g~ o A N O P M=, SO O @ %‘; . =

Read SEUMUM SR
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La estructura que se proporciona
& EJIE_BASICO -

EA
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para la creacion de los requerimientos del sistema es la siguiente:

© Fle Edit Wiew Project Diagram  Element  Tools  Add-Ins  Setbings  Window  Help

‘0w DA E@. BTEe d g AW A )
Todbsx Y B X it Page x | i
I | : : |
LAl v | 2~ 5~ ; :
! _ ENTERPRISE | In g CHEd W4
Analysis ARCHITECT s.5 ZElbAEE = ij Disefio
| - - Modula Funcional
2 Actor L )
: . . # Requerimizntos Del Sistema
™ object My Profile... - [@] Casos de Uso
| = Process Set Local Optians. .. -+ B2 Casos de Uso
3 Collaboration Online Resources & Tutorials - Diagrama de Clases
O Send F\rquitectL!ra Si.stema
| Construccion Sistema
| 1 Receive : isefio Fisi
htanage Projects Recent Disenefisicd Dakos.
b = - Iigracion v Carga Inicial Daky
| Use Case | - Plan de Prusbas |
Class * Operi & Project File, exporbado Entidades Implicadas
I & : EJEMPLC
| Compostee i greate aBNewg'rQJectt... B
opy a Base Praject... .
Communication Py ! Formacion
I = Connect to Serer. Formmacian ¥IP
Inkerackion =
| ea
Timing prusba
== ea_t7%a
Stat =
[ PetStore. GEE
Ackiviky PetStore GEE
Zomponent
Deployment
Custom
| Frofile |4 Start Page
| Metamodel .i'_l'estilj_g
#ML Sch ™ S,
| B =
| DHEL 1| Test Status [ |
Requirerments

Maintenance

User Interface

1

4 4 » M Unit 2 Integration

System Acceptance /4 Scenario

#

2 " 7| Defauk style - J- = e ML P, - 0 2 8= a8 o o O =/ 0 0 O

| 3|

Casos de Lso

El primer paso que se debera realizar es crear tantas carpetas como médulos funcionales se vayan a
analizar e incorporarlas al diagrama principal. Para ello bastara con arrastrar de la barra de herramientas de la
seccion de Analysis el objeto Package sobre el diagrama.
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EJie

A

File Edit Mew Project Diagram  Element Tools  Add-Ins  Settings  WWindow  Help
D& W o BDSEO. BB D Mm ADA D, A Ak~ OB A B 4
{Toolbox T ® X | UseCaseDiagam 'Casos de Uso" created: 13/11/2005 modified: 21/04/200812:41:14 100% 827 %1163 el TR
| I o : = |
N | Al B-B-cfBa g
Analysis = [jijiseﬁo
lse Case = Modula Funcional
I £ Requetimienkos Del Sistema
Actar [®] Casos de Uso
Use Case o RE Casos de Uso
Collaboration = Bu;on Entiads
= uzon Entrada
#Z Buzon Entrad
Boundary Buzon Enirads [_] sistema Programador
Package = = %8 Siskema Programad |
Use Diagrama de Clases |
=] Arquitectura Siskema
Class e Construccion Sistema
i = = Diserio Fisico Datos
| Composite Iigracion y Carga Inicial Daky
Communication Plan de Pruebas |
I = Entidades Implicadas
Inkerackion Sistema Programadar
Timing
Stake
Ackiviby
Cormnponent
Deployment:
Custom .
| Profile 4 Skart Page\ *Casos de Uso ] I
| Metaitnds) .iTesting = 8 eS|
i = X AEe |
| EE Test Status Il | [ TaLes
Requirements :
Maintenarice - il [Farralonng || |
User Interface o4 p i Unit Integratiuon System 4 Acceptance /4 Scenario : T]EIP..; @R.. P.. Q@P.. Q@T.. &N..
25 P | Default style - J- 5 e EE R AR O S N S =
- |

Use Case Diagram: Casos de Lso

Por cada paquete, se crea un diagrama en el que se deberan modelar los distintos casos de uso que
forman parte del modulo funcional que se esta modelando.

Para ello se deberan identificar los actores y los casos de uso en los que intervienen dichos actores.
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@ EJIE_EJEMPLO - EA g@@'

File Edit Miew Project Diagram  Element Tools  Add-Ins  Settings  Window  Help
QDS EQ. DWo @ Mp ADRID, A s Auk- OB AR

Usze Caze Diagram; "Buzon Entrada®  created: 19/11/2005 modified: 05/03/2008 16:24:07 100% 7951130 b4 s

o 2 B-@-cEa g
. .Analysis | ] @ Disefio |

: Modula Funicional

Use Case T

I - @ Requerimientos Del Sistema
2 Actor = [@] Casos de Uso

| Usecase : - 22 Casos de Uso

|42 Collaboration (21 Buzon Entrada
Izl Boundary Gestion Usuarios . . . =8 Diagrama Clasés
B3 Package e = : I_?} - = Gestion Empleados
S e e . @ @ Gestion Usuarios

| e AR S5 - F1 Gestion Empleadas
Class G :__““ = ] Gestion Usuarios

I ) —= _"“H-._‘“ I:l Sistema Programador

| Somposite g A S N o @ Administradar
Communication - o R User

I B 1 - Diagrama de Clases

| Inkerackion | Gestion Empleados o Arquitectura Sistema

| Timing e Construccion Sistema

i— =8 Disefio Fisico Datos

Stake
I [ Migracion v Carga Inicial Datos

[lhctizity =f - Plan de Prusbas

Component - Entidades Implicadas
Deployment:

| Custom ( | 3

| Profile q Start Page L ASistema Programador L Casos de Uso\ Buzon Entrada ] b

Metamadel | ;I_?St_iﬁ:g e
e 5@ |

WSOL | Test Status

| #ML Schema

Requirements

Maintenance Run By

3 < | >
| User Interface IS B I Unit 7 Integratian System 4 Acceptance A Scenario .EP..;@R..P..QQP..QQT..GN..

L Eed Qaee ) &

T G N || E R g -
b bz $ 0 | Defaukt Style J Bl &

En cada caso de uso, se debera informar el campo Name, y el campo Notes.
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¥ UseCase : Gestion Usuarios

General |F|eu:|uire | Constraints | Link !I Scenana || Files |

M ame: | Geztion Uszuanos |
Stereotype: | b | Q.-'—‘-.Igstract ol
Author: w | Status: Fropozed b
Scope: Public w | Complegity: | Easy bt
Aliaz:; Language: | ¢panes b
Fewaords: |
Phase: 1.0 | Version £I
Motes:

Cazo de Uso gue gestiona los usuarios del sistema.

Apply ] [ Q. ][ Cancel ][ Help

Por cada caso de uso se deberan definir las pruebas que se van a realizar, para ello desde la pestana
Require se agregaran tantos test como sean necesarios, tal y como se indica a continuacién
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&' UseCase : Gestion Empleados

Requirement;

Tipe:

TST-003 | Testing v |
Status: DrifFicouatty: Friority: Last Update:
iF'ru:upu:used L¥ || hedium L ||Meu:|ium w " SR 20ne |
Prueba de Tes|

W] B

Defined

Hequirement Type E sternal
TST-001 Testing

TST-002 Testing

Apply ] [ Q. ][ Cancel ][ Help

Una vez introducidos los datos se pulsar el botén Save.

En la pestafna Constraints, se podran definir las condiciones en las que se realizar el caso de prueba
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&' UseCase : Gestion Empleados

Conztraint;

Frecondicidn Type: | Pre-condition % |
Statuz | Approved v |

Se trata de la precondicidn de la gestion de empleados

Defined Cornatrainits ﬂl ﬁ‘ | Mew | Save

Conztraint Type Status

Frecondicion Fre-condition:  Approved
PostCandicion Post-condition  Approved

Apply ][ Q. ][ Cancel ][ Help ]

Y en la pestafia Scenario, se indicaran los distintos escenarios del caso de uso

101/178



- Eusko Jaurlaritzaren Informatika Elkartea
l Sociedad Informatica del Gobierno Vasco

&' UseCase : Gestion Empleados

| General || Require || Constraints || Link | Scenano | Files |

Scenarnio: Type:

| Precondicion | I.-'l'-.lternate w |

Se zelecciona la opcion del filkro

Scenanios _ﬂl _ﬁ_l Save

I arne Type
Precondicion Alterrate
Froceszo Alternate
PostCondicion Alternate

Apply J [ ok J[ Cancel J[ Help ]

Los actores una vez identificados se deberan ubicar al mismo nivel que los mdédulos funcionales, de tal
forma que se puedan compartir entre los distintos casos de uso
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@ EJIE_EJEMPLO - EA E@E|

: Fle Edit Wew Project Diagram Element Tools  Add-Ins  Settings  Window  Help

D) el ROS EQ. REc & M ADRI B, cSukc OBABEIR. .
| Tonlbox Use Case Diagram: "Buzon Entrada” created: 19/11/2008 modified: 05/03/2008 16:24:07 100% 79541130 x  [ISIECHEI0NER: L

12— A B-B-cimid |
Analysis b @ Disefio
. Use.Case = [ Modula Funcional

@ Requerimientos Del Sisterna
= [@] Casos de Uso

Use Case © - BE Casosde Uso

(21 Buzon Entrada

D Siskerna Programadar

Actor

Caollaboration

Eoundary Gestion Usuarios : L % Adninistradar
Package i = : - g User
Use e e w Diagrama de Clases
| D 35 Arguitectura Sistema
Class - MR Construccion Siskerna
I - — SR Diserio Fisico Datos
| Composite | Administradar -"“*--.,“‘ IMigracion v Carga Inicial Datos
Communication = - Plan de Pruebas
I = - Entidades Implicadas
Inkeraction Gestion Empleadas
Tirnirg
State
Ackivity
Caomponent
Deployment
! ¥
Custom 1€ 1 S
Profile q Start Page L Adistemna Programadar L Casos de Uso\ Buzon Entrada I
Metamadel ;T_gst_ih:g bl X
| XML.S.che.ma | "@ |
WDL Test Status st | [l
Requirements
Maintenance Riin By Checked By aebRur i___ os | _(_ | l
User Interface M4 b M Unit A Integratinon System 4 Acceptance 4 Scenario EIP..Q @R.‘ P.‘ Q‘@P.‘ C@T.. GN..
2 : : TE P peFaul stle - g = I A @SR W QS a0 e =
|
Disefio

Una vez definidos los casos de uso, por cada uno de ellos vamos a crear su diagrama de secuencia. Para
ello se debera seleccionar el caso de uso y con el boton derecho, seleccionar Add->Sequence Diagram
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EJie

EX

Add-Ins ifindow

BB @ MM ADR B A

Settings Help

r Ak~ I[1B A B

Use Caze Diagram: ''Buzon Entrada"  created: 19/11/2005

modified: 05/03/2008 16:24:07 100% 795 %1130 HEA

I it —— Iy _ = 1l
| Al B-B- 083 g |
Analysis | g @ Disefio |
Use Case i a | | liEJ Modulo.FL.lncionaI .
I Hi - Requerirnientos Del Sistema
Actor = [®] Casos de Uso
Use Case : -+ #Z Casos de Uso
| o
& Collaboration & Bugon Entrady
) ) -~ 2 Buzon Entrada
Boundary Gestion Usuarios . 8 Diagrama Clases ||
Parkage e =
Properties...
Lse SHEH
] i Analysis Diagram | Add P|
| Class |i= -
i r— Activity Diagram
Composite L
| | Adrministradar =l ‘Sequence Diagram
Communicakion | R .
! | TTaea Cormmunicakion Diagranm o
i- _Interactlon | Statechart o
i N Create Link...
State ﬁ Find in Diagrams. .. Chrl+
| Ackiviby Locate in Current Diagram
; Component Copy RTF Bookmark
Deployment Linked Document ... CtrlH-alt+D
[k I . ] Add Custom Reference...
| Profile Start Page L “ASistema Programadaor L Casos de Uso\ Buzon Entrada ]
I . @ Move up
| Metamadel ~
- . B Mave down
| #ML Schema sd @
WDL Status ] Test: ¥ Delete 'Gestion Empleadas
| Requirements Status: w Type: e @ Help...
| Mairtenance || Run By: w | Checked By: w | Last Run: ||:|:-'_'; |88 IS I | 2|
(i User Interface M4 » M Unit 2 Integratiuon System Acceptance 4 Scenario |E|P @R.. @P.. D@P.. D@T.. GN..
LA [T E 5 | et sive ez i o nElEDE QRARR D [ BESY X .

Todo diagrama de secuencia que se cree, debera presentar la siguiente estructura(Seleccionar diagrama
y pulsar Properties del menu que se muestra al pulsar el botén derecho)
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M ame: iGestiDn Empleadoz- Sequence
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Buathar: I.T he Administrator

¥ Stereotype: |Sequence W | |.-“-‘-.4 Sheet, 210- by 297-millimeters
Wersion: |1 0 | Created: : | , F y
o = Landscapa -_vann:e

Zoom: (100 v Modfied:  |04/03/200817:15:43 |
Appearance Dptions

Ilze Stereatype lcons Show Page Barder Yizible Compartments Wizible Clasz Memberz
Show Element Stereatypes - [] Shaw Details on Diagram Altributes Public

Show Feature Stereotypes Show Felationships Operations P’F'tECtE'j

[] Use s if Available ] Sk NeriNavigabis Ends. |- =8> Pivate

Show Additional Parents [ Show Sequence Notes [ HEII]L,IIIE.ITlEHtS Fackage

S how Yisibility [ndicators Show Collaboration Murbers o I:l:lns.tralnts Property tethods
[] Show Table Owner [] Tes.tlng .
Highlight Foreign Dbjects [ ] Maintenance Show Parameter Detail;

e o

Show Element Property Sting Package Contents | Type Only

Show Feature Property Sting

: |
Show Connectar Property Shing Connector Notation | UML 21 adl]
Document Options -
[ E=clude image from RTF Documents Document each cantained element in BTF [ Set Lapout Shyle ]
[ obes:
A]
Apply ] [ ok ] [ LCancel ] [ Help ]

Para el modelado de los casos de uso, se deberan utilizar las clases definidas en la seccién Entidades
Implicadas.

5.3.2.Generacion Documentacion

Los accesos directos que se han de ejecutar para la creaciéon de los documentos intermedios son las
siguientes

ASI_1_Modulo_Funcional
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Generate RTF Documentation

oot Package: I_J|III Fuhciona |

Dutput ta file: |E:'\LIML'\Dcun:umentu:us'\-.f-‘-.SI"-.Du:u:s'\.-'-‘-.SI_'I_Mu:u:lulu:u_Funn:i-:unaI.rtf |[ ]

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurment

Use Template: | ASI_1_Madulo_Funcional v |
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
[ ] Usze Intemal Viewer Ilze Language Substitutions

Progress:

ASI_2_Indice_Requisitos
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EJie

oot Package:

FIE:I Lenmientos Diel Sistema

Cutput ko file:

|E:xUMLxDu.:umenmsmshDucsms|_2_|ndi.:e_Hequisims.rtf |[ ]

RTF Docurment

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

Use Template: | AS|_2 Indice_Fequisitos

&l

[ Manage Templates. .. ]

[ Edit Current... Generate ]

| |

[ Heb |

] |

Close ]

Dptionz
[ ] Usze Intemal Viewer

Progress:

Ilze Language Substitutions

ASI_3_Detalle_Requisitos
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EJie

oot Package: FIE:. Lermientos Tel

Siatem

Cutput ko file:

|E:‘»LIML‘»Du:u:umentu:us'\-.f-‘-.SIRDncs'\.&SI_3_Detalle_Hequisitns.rtf |[ ]

RTF Docurment

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

Use Template: | 4513 Detalle_Requisitos

&l

Llﬂanage Templates. .. ]

[ Edit Current... Generate ]

| |

[ Heb |

] |

Close ]

Dptionz
[ ] Usze Intemal Viewer

Progress:

Ilze Language Substitutions

ASI_4 _Casos_Uso
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Generate RTF Documentation

oot Package: Ij.a:g.:.:s: delzn |
Dutput ta file: |E:"xLIML'\Du:u:umentu:us'\.ﬁ.SI'\.DDCS'\.&SI_#_EaSDs_LISD.rtf |[ ]
[ Fenerate Options. .. ] [ Resource Qu:u:ument...]
RTF Docurmnent
Ilze Template: |L-'!-.SI_4__I:a3|:|s_LIS|:| V1
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
[ ] Usze Intemal Viewer Ilze Language Substitutions
Progress:
| [ ]

5.4 Definicion de la Arquitectura del Sistema — DSI 1

5.4.1.Modelado UML

Para la generacion de la documentacion, se han de actualizar de la estructura estandar el siguiente

diagrama

Arquitectura Sistema

La estructura que se proporciona es la siguiente:
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EJie

@ EJIE_BASICO - EA EX

: Fle Edit YWiew Project  Diagram  Element  Tools  Add-Ins

DEH B RDS Ee. BN A MM EDR D,

Settings

“iindow

Help

- Auk- LB ABR

Eoalbes Yo x
T | I = |
| A B-B- 7R 4 F |
Analysis = @ Disefio |
- [ Modulo.FL.lncmnaI .
I Requerimientos Del Sisterna
| Class [®] casos de Uso
Composite = Arquite Ema
| e = [ Arquitectura Sistema
I Rl el H -8 Arquiectura Sistema
Interackion = ] Soparts
| & [ -8 Soporke
2 Actor = ] Catalogo Requisicos
B3 Lifeline - Fg Cétalogo de Requisitos
| IQ Boundary i D Requisitos de Implfntacwén
(:, Cantral B fo =1 Requisitos de disefio v constru |
3 f 21 Requisitos de documentacién d |
Q Egticty £ -] Requisitos de operadidn v segu_:
| Fragrment(s) =[] Catalogo Mormas |
| : P Cétalogo MNormas
Tirning - =[] Entorno
Shib i EIE Entorn.o Te.cnolog\co
e 2] Comunicaciones
| Activity i <[] Hardware
Companent i [j Infraestructura
I -] Software
| Deployment #- [B| Diagrama de Clases
Cuskar i E=] Construccion Siskema
| ; & = = I R4 ==} Disefio Fisico Datos
| Profile |4 Start Page L *Casos de Uso L *Buzon Entrada\ Use Casel ] b @B Migracion v Carga Inicial Datos
&
| Metamodsl | Fostina g @ Plalj de Prueba.s
WML Schema "D T @ - [ (3| Entidades Implcadas
s | | ™ W= - W ‘
| .WSDL Test Status | Test: |
Requirements T 7 :
e Status: Type:| bl
Maint T 1 =il | >
(SRS o) | Run By w | Checked By:| ~ | Last Rum: ||:| 1= : —I|
User Interface M4 » M O Unit A Integration A System 4 Acceptance /4 Scenario _EIPr.... @R P... QmPr... Q@T GN
2 P Defad Style - g & [ 25] 35 23 B B | BB A | @) C) 8 | & & =
)

Para creacién del modelado en UML, se deberan seguir distintos pasos en funcién de la carpeta en la se

este trabajando:

Arquitectura Sistema

Desde la carpeta Arquitectura Sistema, se debera afiadir tantos paquetes como niveles de

arquitectura presente la aplicacion.
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@ EJIE_EJEMPLO - EA B@E'

© File Edit Wiew Project Diagram  Element Tools  Add-Ins  Settings  Window  Help
‘D B DS Fo. BB & W@ aDR . A - Ak~ 1B A B
{Toolbox ¥ ® X | Component Diagram: "Arquitectura Sistema” created: 22/10/2007 12112:28 modifiec 21/04/2008 1455:14 100% 827 x Wil i |
I T i . |
i ] A BB cBa AR
Analysis = [,fj Disefio |
| .Use_Case Madule Funcional
I P—.l Requerimientos Del Sistermna
resentacion
| Class [®] casos de Uso
Composite Arquitectura Sistema
| o T Geremua ! P =
Communication | T e Properties...
e [ +es
Interaction @ Package Control b
(RS ) senit ‘Ig Add Diagram... Add L4
| State QL‘ L antd L -
— Negacio . i8] Add Element... Ctr+m T .
chivity a5 : -
I 4 - |[:‘ Add Package... i | Code Engineering LS
Component
I R 5 Add Model using Wizard. .. Build and Run (3
Package =
| =) d : - S—| Import /Export 4
| {l Component ! 3 ervicios
| 1 Transform Current Package ChrH+Mayusculas+H
B class 5 B §
|0 pri
Interface T Contents »
M object Bookmarks
o Port By sSearchin Project Browser. ., Chrl+Mayusculas+F
. Bisplnbient = Copy Mode Path to Clipboard
Cuskam P I Save Package as UML Profile
| Profil | Start Page Arquitectura Sistema
| Profile :.4 \ A Moveup
Metamode! Testing @ s e
| #ML Schema [ el B 3 :
[ — | ¥ Delete ‘Brguitectura Sistema’
WiSDL | Test Status Test: d - o
| Requirements Status: Type:| v @ Help...
Maintenance Run Ey: v| Checked By: | w | Last Run: ||:|j-j'; 11 |
P ST

| User Interface

o )

&

7| Default Style

M4 kM Unit ¢ Integration System Acceptance /4 Scenario

x -l e

A i I S | MO MO MO HE TN -

B, .| G &p

Add new package to project

74 Inicio

IML\Eritregar

5101 pdf - Ada...

@ ENEEEMRLO-EA | 8 EA Manualdeus... | G EJE |

Una vez creados los paquetes se deberan arrastrar al diagrama y establecer sus relaciones. Por cada
nivel de arquitectura se podran agregar tantos caracteristicas como se consideren necesarios (El
proceso es el mismo que cuando se agregan requerimientos, punto 3.3.1)

El diagrama de Arquitectura de Sistema debera presentar las siguientes caracteristicas:
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Component Diagram: Argquitectura Sistema

[ oo e Page Si
Mame: |Arguitectura Sistema 8ge aze

Avtthar: Ign:-n bh L7 ' Stereatype:; | v |.-’-‘-.4 Sheet, 210- by 297-millimeters

Wersion: |1.0 | Created: N BA2007 |
fr— | Landszaps Advanced...

Zoom: (100 v Modiied: | 21/04/2008 145514 |

Appearance Dptions

Uze Sterectype |cans Show Page Border Wizible Compartments Yizible Clazz Members

Show Elemert Stereotypes || Shaw Details on Diagram Altribtes Public

Show Feature Sterectypes Show Felationzhips Operations PfPtECtEd

[ Use dlias i Awvallable [l Shous Moriaviabie Ends: | 1) La0=. Private

Show ddditional Farents [] Show Sequence Motes Flequue.ments Fackage

Show Visibility Indicatars Shaw Calabaration Numbers. | Lanstraints Froperty Methods

[ ]5how Table Dwner [ TES_t""Q _

Highlight Forsign Dbjects [ ] Maintenance Show FPararneter Detail

e

Shaow Element Property String Package Contents | Type Only |

Show Feature Property String _ i

Show Connectar Property String Connector Notation | UML 21 |

Dacurment Dptions -

[ 1Exclude image from B TF Documents [] Document each contained element in BTF [ Set Layout Shyle ]

Motes:

ooy | [ ok || cancel || Hep |

Arquitectura Soporte

El modelado en esta seccidon es el mismo que el que se realiza en la Arquitectura de Sistema
Catalogo Requisitos

Desde la carpeta Catalogo Requisitos se deberan anadir tantos elementos por paquete como sean
necesarios. (El proceso es el mismo que cuando se agregan requerimientos, punto 3.3.1)
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@ EJIE_BASICO - EA E
File Edit Mew Project Diagram  Element Tools  Add-Ins  Settings  WWindow  Help
D QDS B9, BBc @ Meu apn o, ~ - ik -
T 0.".3'.:?.6_ Requirements Diagram: *'Catalogo de Requisitos”  created: 224102007 12:11:04 modified: 30/10/2007 17:61:06 x|
W A BB lcieed w4 b
Analysis ] Disefio
|z | Modula Funicional

Use Case
| Requetimizntos Del Sistema
| Class [®] casos de Uso
Compasite Arquitectura Siskema
I T [:l Arquitectura Sistermna
| Communicakion [:I Soporte
Inkerackion [:l Catalogo Requisitos
i - B cétalogo de Requisitos
| Tirning | Requisitos de disefio y construccidn Requisitos de operacién ¥ seguridad H i - D Requisitos de Implantacion
State : : e 2] Requisitos de disefio v const
| .\.lc.éivi.ty | - |21 Requisitos de documentacic
| : - 2] Requisitos de operacidn v st
Component —r e — Aad7 FublcPatka ) l | Catalogo Mormas
I = equisitos de operacidn v seguridad ¢ Public Package 2 :
Deployment e o E?=E CAtalogo Normas
i i ] ntorno
| Custom | : - =8 Entarna Tecnalogico
Prafile : ‘o 2] Comunicaciones
I Requisitos de dacumentacidn de usuario Requisitos de Implantacidn i . D Hardware
| Metorede) | : [ Infraestructura
#ML Schiema ‘ 77 Safhwars :
f { I |
WSDL T T
== l'-[EIF'mject Browser @Resources

Requirements

'Pan & zoom
1 Package : ‘
[E Requirement BAE 6 QA - =
| = Feature =
H  object :IE =
A hgoregation
/' Inheritance
b— 3
| Maintenance | v--;<_ = . . . | i | .
User Interface 4 \\ *Buzon Entrada ] Lse Casel ] *Arquitectura'Si'stema \\J\ Catalogo de Requisitos | Is _Pan... Q“@Pro... Q%Tag... GNotes
- A 2 " 7| Defadk Style = S B s B i W SHe A AR CROMOM e ¥ X B
2

Ready

El diagrama debera presentar la siguientes caracteristicas:
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Requirements Diagram: Catalogo de Requisitos

Mame: E-é.talugl:u de Requizitos | Page Size
Authar: |gon bb L7 | Stereotype: | v | |.-’-‘-.4 Sheet, 210- by 297-millimeters |
Version: (1.0 Created: A RAR00T |
| == Landzzape Advanced...
Zoom (100 v Modified:  |30/10/2007 17.51:06 |
Appearance Options
Lze Sterectype |cons Shaw Page Barder Yizible Compartments Yizible Clazs Memberz
Show Element Stereotypes [ Show Detailz on Diagram Attributes Public
Show Feature Stereotypes Shaw Relationships Uperations PfPtECtEd
[7] Use Alias f Available [l Show NonNavigable Ends: | - = 1395 Private
Show Additional Parents [ ] Shaw Sequence Nates [ HE':IU"E_""EMS Fackage
Shavs Visibility | ndicators Show Callabotation Numbsis: | 1 Lornstraits Froperty Methods
[ ] 5how T able Dwrer L] TES_“”E' _
Highlight Foreian Objects [] Maintenance show Parameter Detal:
Show Element Property String Package Contents | Type Orly 1]
Show Feature Property String
i Connector Notation | UML 2.1 v
Show Connectaor Property Sting TilalE AR e | : |
Dacurment Dphions -
[ 1Ex=clude image from RTF Documents [ 1 Document each contained element in RTF [ Set Layout Style ]
Motes:
|
[ Apply ] [ Ok ] [ LCancel ] [ Help ]

Catalogo Normas

Desde la carpeta Catalogo Normas se deberan afiadir tantos elementos como sean necesarios. (El
proceso es el mismo que cuando se agregan requerimientos, punto 3.3.1)
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@ EJIE_EJEMPLO - EA D@E|

© Fle Edit YWiew Project Diagram  Element  Tools  Add-Ins  Settings  MWindow Help
‘Dl 2B RLE EFL. B%c d mp 2B0 .4

!ITE?.“.JFEX. Component Diagram: “Entomo Techologico”  created: 22/10/2007 12:24:43 modified: 14/04/2008 17:58:26 100% 827 %

- Auk- LB ABR

v A BB cBeBWmAD |

Analysis = [ Disefia

Modulo Funcional

Use Case
t Requerimientos Del Sistemna
Class
I Infraestructurs = 4
Composite = Arquitectura Sistema
I ]+ Estranet Hardorsia [ [:] Arquitectura Sistema
Communication + Internet z o
| : FD-I + Intranet (0 + Clientes £ L1 soporte -
. Interaction :] D - nrataras 4 = % atalogo Requisitos
- (7] + Senidores ’ i
| Timirig & - I3 +Functionaks EE_0002|
State ; - & «Functionals Utiizacin ||
| .\.lc.tivi.ty I:I Entarno
e i —l Diagrama de Clases
Component Sofbvane Comunicaciones Canskruccion Sistema
I 7 5 rah [ + Base de Datos 5 + A0SL Router Disefio Fisico Datos
(2] + Firewalls §] Ethemet Adaptor Migracion y Carga Inicial Datos
B Component (] + Henamientas G+ Pructa Flan de Prushas
B Cass [+ dava
o0 Interface D + Librerias
M object
0 Port
Deployment -
! il v
Custam |8 | > =
Prafile 4 . Soporte L Catalogo de Requisitos \ Entorno Tecnologico I
Metamadsl Testing ¥ ax
#ML Schema [k @ |
WSDL Test Status Test:
Requirements Skakus: w Type: |
Maintenance Ruri By: v | Checked By: | | Last Run: H:l | | [ | 2|
User Interface M4 » M O Unit A Integration A System A Acceptance /4 Scenario lEIP @R P... Q‘@P Q@T GN

x ¢

gt ,’;' | Default Style

z ol LlaRd @aean &

Entorno

Desde la carpeta Entorno se deberan afnadir tantos elementos por paquete como sean necesarios.
(El proceso es el mismo que cuando se agregan requerimientos, punto 3.3.1)
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File Edit Yiew Project Diagram  Element Tools  Add-Ins  Settings MWindow Help

0 LS F@. B%Bc &% abn . v Auk- B A B

5

Companent Diagram: “Entoma Tecnalogica”  created: 22/10/2007 12:24:43 modified: 14/04/2008 17.58:26 100; x  Projct Browser TR
Al BB cmalwmer |
Analysis = @ Disefio
- B Modulo Funcional
I gquerimientos Del Sistema
7] Requerimientos Del Sist
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I Infraestructurs
Composite Arquitectura Sistema
| Hardware 21 arquitectura Sistema
| Communication | [:I Soports
Interackion £ [:l Catalogo Requisitos
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g | = ] Entorno
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Activity o I:I Comunicaciones
| : = —l o [C Hardware
Component - Rathene Comunicaciones . [:I Infraestructura
B Package 0 | <[] software
=] Diagrama de Clases
&] Companent Construccion Siskerna
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M object P|al.1 de Prueba.s
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Component Diagram:Entorno Tecnologico

El diagrama presentara las siguientes caracteristicas:
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Component Diagram: Entorno Tecnologico

M ame: IE-ntl:urnl:u Tecnologico | Page Size
Authar: |gon bh LT | Stereatype: | v | |.-’-‘-.4 Sheet, 210- by 297-millirmeters |
Versior: 1.0 Created: S EARI0T | -
e — — Landsc Ane '&'dvanced.“
Zoom: (100 v Modiied:  |14/04/200817.58:26 | | itiapeati )
Appearance Options
Uge Stereotype lcons Shaw Page Border Yizible Compartmentz Yizible Clazs Members
Show Element Stereatypes 7] Show Details on Diagram Attributes Public
Show Feature Stereotypes Show Relationships Uperatiors PfPtECtEd
[ ] Use Alias if Available [ ] Show Non-Mavigable Ends TE'QS_ Private
Shaw Additional Parents [] Show Sequence Nates [ HE'ZIU”E_""'EVItS Package
Show Visibility Indicators Show Collaboration Nurnbers o EDngtramts Property Methods
[] Show T able Owner L] TES_“”Q _
Highlight Forsign Obiects [] Maintenance Show Parameter Detal:
Show Element Property String Package Contents | Type Only 1]
Show Feature Property String _ |
Show Connector Property String Connector Notation | LML 21 ¥
Document Options -
[ 1Ex=clude image from ETF Documents [ 1Document each contained element in BTF [ Set Layout Shyle ]
Motes:
|
| ey || ok || Cancel || Hep |

5.4.2.Generacion Documentacion

Los accesos directos que se han de ejecutar para la creacion de los documentos intermedios son las
siguientes

DSI_1_1_Sistema
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Generate RTF Documentation

Root Package: | Arguitectura Sistema |

Clutput ta file: |E:‘\LIML"\D ocumentosiDS 114D ocs\DSI_1_1_Sisterna.rtf I ... ]

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurment

Use Template: | DSI_1_1_Sistema v |
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
[ ] Usze Intemal Viewer Ilze Language Substitutions

Progress:

DSI_1_2_Soporte
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Generate RTF Documentation

oot Package:

Clutput ta file: |E:‘\LIML"\D ocumentosiDS 114D ocs\DSI_1_2_ Soporte. it I ... ]

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurment

Ilze Template: | D51_1_2 Soparte ! |
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] | Wi, | [ Close ]
Dptionz
[ ] Usze Intemal Viewer Ilze Language Substitutions

Progress:

DSI_1_3_Requisitos
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Generate RTF Documentation

oot Package: I:Z.ataln:u:ln:n Rer ui:zn:n:z:

Clutput ta file: |E:‘\LIML"\D ocumentosiDSI114Docs\DSI_1_3 Requisitos f I ... ]

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurment

Use Template: | DSI_1_3_Requisios v |
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
[ ] Usze Intemal Viewer Ilze Language Substitutions

Progress:

DSI_1_4 Normas
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Generate RTF Documentation

oot Package: | Catalogo Mormas |

Clutput ta file: |E:‘\LIML"\D ocumentosiDSI1500cs\051_1_4 Nomas if I ... ]

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurment

Use Template: | DSI_1_4_Normas v
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
[ ] Usze Intemal Viewer Ilze Language Substitutions

Progress:

DSI_1_5_Entorno
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Root Package: | |
Clutput ta file: |E:‘\LIML"\D ocumentosiDS 114D ocs\DSI_1_5_Entome.itf I ... ]
[ Fenerate Options. .. ] [Hesu:uuru:e Qu:u:ument...]
RTF Docurmnent

Ilze Template:

|DSL18 Entorno

vl

—

[ Manage Templates. .. ] [ Edit Current... ]

[ Generate ]

[ Help ] [ Wi, ]

[ Close ]

Dptionz

[ ] Usze Intemal Viewer Ilze Language Substitutions

Progress:

5.5 Diseio de Casos de Uso Reales — DSI 3

5.5.1.Modelado UML

Con el modelado realizado en la fase de Analisis del Sistema de Informacion, el modelado
correspondiente a la documentacién del Disefio de Caso de Uso, se encuentra realizado, por lo que solo se ha

de proceder a la generacion de la documentacion correspondiente.

5.5.2.Generacion Documentacion

Los accesos directos que se han de ejecutar para la creaciéon de los documentos intermedios son las

siguientes

DSI_3_1_Requisitos_Usuario
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Generate RTF Documentation

oot Package: | Casos de

Dutput ta file: |E:'\LIML'\DDcumentns'\DSIS'\DD:S'\DSI_SJ_Hequisitus_Llsuariu:u.rtf |[ ]

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurmnent
Use Template: | DS|_3_1_Fiequisitos_Usuaria v |
[ Manage Templates. .. ] | Edit Current... | [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
[ ] Usze Intemal Viewer lze Language Substitutions

Progress:

DSI_3_1_Agrupacion_Caso_Uso
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EJie

oot Package:

| Cazos dellzo

324

Clutput b file: | CAUMLADocumentosh DS 3D oce\DSI

grupacion_Cazo_Uzo.rtf |[ ]

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurment

Usze Template: | D51_3_2 Agrupacion_Casos_Uso i |
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]

Dptionz
[ ] Usze Intemal Viewer

Progress:

Ilze Language Substitutions

DSI_3_3 Casos_Uso
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Generate RTF Documentation

oot Package: |:E|:E:|:|:E: de zo |

Clutput ta file: |E:‘\LIML"\D ocumentosiDSI3DocsiDSI_3 3 Casos_Usof I ... ]

RTF Docurmnent
Ilze Template: | DSI_S_S_I:a_s_l:ls:g:sn V1
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
[ ] Usze Intemal Viewer Ilze Language Substitutions

Progress:

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

5.6 Diseno de Clases — DSI 4

5.6.1.Modelado UML

Para la generacion de la documentacion, se han de actualizar de la estructura estandar el siguiente

diagrama

Diagrama de Clases

La estructura que se proporciona es la siguiente:
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Diagrama de Clases

El Diagrama de Clases presentara las siguientes caracteristicas:
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Component Diagram: Diagrama de Clases
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Desde la carpeta Diagrama de Clases, se debera afiadir tantos paquetes como maédulos funcionales se
hayan definido:
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Una vez creados los paquetes funcionales se deberan crear tantos diagramas de clases como casos de
uso se hayan definido en el modulo Casos de Uso por paquete funcional, de tal forma que cada diagrama tenga
como nombre, el del caso de uso al que hace referencia. Para ello se seleccionara una de las carpetas y a
través del menu emergente que se muestra con el botén derecho se pulsar Add-> Diagram
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New Diagram E|
W arne:; !Euzl:un Ertrada | ["é""‘t':']
Tyupe
Select Fron; Diagram Tppes:

@ ML Structural EY Package

[[7 UML Behaviaral

llEj Extended E’E Ohject
|9@Q| Composzite Structure
98 Component

?EI Deployrment

IJML Clazz Diagrams capture the logical structure of a
zyztem as a senes of claszes, ther features and the
relationzhips between them,

] ][ LCancel ][ Help

A continuacién y una vez creados los diagramas a implementar se procede al disefio del diagrama de
clases.
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Gestion Empleados

Una vez establecidas las relaciones entre las distintas clases, por cada una de las relaciones establecidas
se deberan crear dos Tagged-Values,(Punto 3.8.1) :

e source -> Nombre de la clase origen de la relacion
o target -> Nombre de la clase destino de la relacion.
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Cada uno de los diagramas creados debera presentar las siguientes caracteristicas:
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Logical Diagram: Gestion Empleados
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5.6.2.Generacion Documentacion

Los accesos directos que se han de ejecutar para la creaciéon de los documentos intermedios son las

siguientes

DSI_4_1_Diagrama_Clases
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Generate RTF Documentation

e Clazes

oot Package: | Diagrama d
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[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurmnent
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[ Help ] [ Wi, ] [ Close ]
Dptionz
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Progress:

DSI_4_2_ Clases
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3

Root Package: | E ntin:l-- licadas

Output ta File: | C:AUMLNDocumentosh DS 4MDocs DS 4 2 Clazes if

[ Generate Options... ]

[ Resource Q-:u:ument...]

RTF Document

v

Progresz:

[ Manage Templates. .. ] [ Edit Current... ] I Generate ]
[ Help ] [ i, I [ Cloze ]
Optionz
[ ] Use Intemal Miever IJze Language Substitutions

5.7 Diseio Fisico de Datos — DSI 6

5.7.1.Modelado UML

Para la generacion de la documentacion, se han de actualizar de la estructura estandar el siguiente

diagrama
e Diseno Fisico de Datos

La estructura que se proporciona es la siguiente:
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El diagrama Modelo Datos presentara las siguientes caracteristicas:
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Logical Diagram: Modelo Datos
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Tanto la carpeta Subsistema 1 como su diagrama correspondiente, debera ser modificada y asignarle el
nombre del Sistema de Datos de la aplicacion. En caso de existir mas de un Sistema se debera duplicar la
estructura proporcionada.

El Diagrama Subsistema 1 presentara las siguientes caracteristicas:
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Logical Diagram: Subsistema 1
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Para agregar tablas al disefio el primer punto consiste en afiadir a la carpeta Tablas, tantos objetos de
tipo Class/Table, como tablas forman parte del sistema, para ello con el botdn derecho del ratén y desde la
carpeta tablas se pulsar la opcion Add-> Element
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New Element
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[ ] Add to Curent Diagram
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Una vez creadas las tablas y sus atributos y métodos (Punto 3.8), se procedera al modelado del diagrama

de entidad relacion.
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El proceso de creacion
Por cada tabla afiadida se deberan crear los siguientes Tagged-Values
e Num_Estim_Reg -> Numero de registros estimados

e Owner -> Propietario de la tabla
e TableSpace -> Nombre del tablespace
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Una vez definidas las tablas, se procedera si es necesario a la definicion de los distintos caminos de
acceso. Para ello en el diagrama Caminos de Acceso, se agregaran tantos componentes como caminos se

vayan a definir. En el campo Notes, de cada componente creado, se debera introducir la descripcion del camino
de acceso que representa:
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& Component : Buscar Empresas Inventariadas

General |F|eu:|uire | Constraints | Link !I Scenana || Files |
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Scope: Priblic w |  Complexity: | Eazy w
Alias: Language: | Java o
Kewwords: |
Fhaze: 1.0 i"-.-"E[SiEIr'IZ |1.EI |
Motes:

| o
{Se trata de realizar la conzulta de aguellas empresas que se
encuentran inventariadas en el siztemna.

Apply ]E Ok J[ Cancel ][ Help ]

El Diagrama Caminos Acceso presentara las siguientes caracteristicas:
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Logical Diagram: Caminos Acceso
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Una vez definidos los distintos caminos de acceso, se deberan agregar aquellas tablas que forman parte
de dicho camino de acceso, para ello se deberan arrastrar las tablas que forman parte del camino al objeto
presente en el diagrama, de tal forma que al arrastralo se presente la siguiente pantalla
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Drop Class As... E|

Ed can automatically create a Port or Fart attached to the
target element. Press ‘Meither' to bypazs this option

Mew Element Type

[ Hewver sk Again [ ak J [ Meither

Se pulsa el boton OK, y de la pantalla que se muestra, en el campo Name se ha de informar el nombre
de la tabla que se esta arrastrando y en el campo Notes, la funcionalidad que se realiza sobre dicha tabla en la
definiciéon del camino de acceso que se esta realizando.

¥ Part : Inventarios
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Phase: 10 i Yerzsion; |T_EI_|
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De aquellaz emprezas recuperadas, se seleccions de cada una de
ellaz el inventaro mas antiguo.

Apply ] [ ak ][ LCancel ][ Help
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Una vez agregadas las tablas a los componentes, es importante definir en la vista del explorador el orden
en el que se ejecutan los accesos a las tablas, de tal forma que se ubique en primer lugar, la tabla que es

accedida inicialmente.

Dicha ordenacion se realiza a través de la seleccion de las tablas definidas en los componentes y
haciendo uso de los iconos Move Element Up (mano arriba) y Move Element Down (mano abajo).
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Caminas Acceso

5.7.2.Generacion Documentacion

Los accesos directos que se han de ejecutar para la creaciéon de los documentos intermedios son las

siguientes

DSI_6_1_Diseno_Datos
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Generate RTF Documentation

oot Package: Di:E:EEﬁI:I Fizica Datos |

Clutput ta file: |E:‘\LIML"\D ocumentostDSIE\DocsDSI_E_1_Disefio_Datos f I ... ]
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RTF Docurmnent
Use Template: | DSI_B_1_Disefia_Datos v |
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
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Progress:

ent suocessiuly created . [ ]

DSI_6_2_Caminos_Acceso
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Generate ]
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[ Help ] [ ] [

Cloze ]

IJze Language Substitutions

5.8

5.8.1.Modelado UML

Diseio Fisico de Datos — DSI 8

Para la generacion de la documentacion, se han de actualizar de la estructura estandar el siguiente

diagrama

e Construccion Sistema

La estructura que se proporciona es la siguiente:
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Construccion Sistema

El Diagrama de Despliegue permite definir la disposicidn de las particiones fisicas del sistema de
informacion y la asignacion de los componentes software a estas particiones.

El Diagrama de Despliegue presenta las siguientes caracteristicas:
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El diagrama de componentes proporciona una vision fisica de la construccion del sistema de informacion.
Muestra la organizacion de los componentes software, sus interfaces y las dependencias entre ellos

La creacién del diagrama se dividira inicialmente en funciéon del numero de capas que formen la

aplicacion y en cada capa se crearan tantos componentes,
capa.

como elementos software formen parte de dicha

Definidos los componentes principales, se podran vincular los componentes secundarios.
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Component Diagram: Diagrama Componentes

El Diagrama de Componentes presentara las siguientes caracteristicas:
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Component Diagram: Diagrama Componentes
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Definido el diagrama de componentes, se pueden llegar a definir los subsistemas de construccién de la
aplicacion en la carpeta Subsistemas Construccion

En dicha carpeta se crearan aquellos subsistemas que sean los suficientemente importantes para ser

definidos y la forma de implementacion se realizara arrastrando los objetos ya definidos y que se encuentran
disponibles en los distintos diagramas ya creados.
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Los diagramas de los subsistemas de Construccion presentaran las siguientes caracteristicas:
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Component Diagram: Generico
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5.8.2.Generacion Documentacion

Los accesos directos que se han de ejecutar para la creaciéon de los documentos intermedios son las
siguientes

DSI_8_1_Construcciéon_Sistema
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Generate RTF Documentation
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Progress:

5.9 Diseno de la Migracién y carga inicial de datos — DSI 9

5.9.1.Modelado UML

Para la generacion de la documentacion, se han de actualizar de la estructura estandar el siguiente
diagrama

e Migracion y Carga Inicial Datos

La estructura que se proporciona es la siguiente:
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Los diagramas que se crean en este apartado presentan todos la siguiente estructura:
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En el Diagrama de Entorno de Migracion se ha de realizar un disefio del entorno de migracion,
haciendo uso de objetos de tipo Component, tal y como se ha indicado en puntos anteriores, de tal forma que
se tengan en cuenta las herramientas o utilidades software especificas
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En el Diagrama Procedimientos de Migracién se definira el proceso de migracion que se va a realizar,
de tal forma que se pueden identificar los procesos que forman parte de la migracion y sus relaciones (quien
invoca a quien, etc).

Para ello se deberan agregar tantas clases al diagrama, como procedimientos existan en la migracién y
cada una de las clases presentara la siguiente estructura:
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Por cada procedimiento almacenado identificada, se crearan tantos Operations, como funcionalidades
proporcione dicho procedimiento:
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En la pestana de Behavior, se podra definir tanto el proceso que realiza el procedimiento a nivel

funcional (seccion Behavior) , como el cédigo o pseudo codigo del procedimiento (seccion Initial Code)
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¥ Migracion Operation: migracion

B ehawiar: [] 5how Behavior in Diagram Sauve

1.- Se establece una conesrion con la base de datos
2.- 5e realiza una llamada al procedimiento 1.

3.- En caso de ir todo cormectamente se procede a la invocacian del
procedimiento 2,

|rutial Code:

Codigo del metodo en cazo de que e encuentre definido

[ Cloze ] [ Help

Creados todos los procedimientos, se incorporaran al diagrama y se estableceran sus relaciones:
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Component. Diagram:Procedimientos Migracion

Definidos los procedimientos que forman parte de la migracion se ha de definir el plan de pruebas para la
misma, para ello se ha de seleccionar la carpeta Procedimientos Migracién y acceder a sus propiedades.
Desde la pestafia de Require, se han de crear tantas entradas de tipo Testing, como pruebas de test se vayan
a realizar para validar el proceso migracion.
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El proceso de modelado de Carga Inicial sera el mismo que para los Procedimientos de Migracion
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5.9.2.Generacion Documentacion

Los accesos directos que se han de ejecutar para la creaciéon de los documentos intermedios son las
siguientes

DSI_9_1_Migracion
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Generate RTF Documentation

oot Package: | higracion v Cama | nicial Datoz |

Clutput ta file: |E:‘\LIML"\D ocumentostDSI90ocsv051_S 1_Migracion. it I ... ]

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurment

Use Template: | DS1_3_1_Migracion v |
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
[ ] Usze Intemal Viewer Ilze Language Substitutions

Progress:

DSI_9_2 Plan_Pruebas
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Generate RTF Documentation

Root Package: in]r-an::in:nru y Cama |nicial D atos

Dutput ta file: | C:AUMLAD ocumentosh DS940 oc:hDS1_9 2 Plan_Pruebas rtf

L)

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurment

v

[Manage Templates. .. ] [ Edit Current... ] [

Generate ]

[ Help ] [ Wi, ] [

Close ]

Dptionz

Progress:

[ ] Usze Intemal Viewer Ilze Language Substitutions

5.10 Diseino de la Migracién y carga inicial de datos — DSI 9

5.10.1. Modelado UML

Para la generacion de la documentacion, se han de actualizar de la estructura estandar el siguiente

diagrama
e Plan de Pruebas

La estructura que se proporciona es la siguiente:
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Component Diagram:Plan Pruebas

Para la definicion del Entorno de Pruebas se deberan definir los siguientes aspectos:

e Entorno Tecnolégico
o Comunicaciones
o Requisitos Hardware
o Requisitos Software
e Herramientas Prueba
e Procedimientos Emergencia
e Restricciones Técnicas Entorno

Para cada uno de los elementos identificados anteriormente se deberan agregar tantos elementos como
sean necesarios(Punto 3.3.1), de tal forma que cada uno de ellos quede bien definido
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Una vez definido el Entorno de Pruebas, se debera definir el Plan de Pruebas, el plan de pruebas
presenta la siguientes estructura:

e Pruebas Unitarias

o Presentacion

o Légica Negocio

o Capa Datos
Pruebas Integracion
Pruebas Sistema
Pruebas Implantacion
Pruebas Aceptacion

Los diagramas correspondientes al Plan de Pruebas presentan las siguientes caracteristicas:
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Component Diagram: Plan Pruebas
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Las pruebas unitarias presentan la siguiente estructura
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Component Diagram:Pruebas Unitarias

Por cada capa definida en las pruebas unitarias se deberan agregar tantos elementos, como pruebas
unitarias se deberan realizar.

La definicibn de las pruebas unitarias se realizara de manera genérica, es decir, identificando
componentes genéricos, como por ejemplo, definicion de pruebas para campos Date, definicion de pruebas para
campos numéricos, etc.

En funcién de la capa en la que se esten agregando las pruebas, los tipos de elementos a agregar seran
diferentes:

e Presentacion
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Component Diagram:Pruebas Lnitarias

Una vez definidos los elementos que seran sometidos a pruebas, se deberan definir las mismas, para ello

se ha de hacer visible la ventana de Testing, accediendo al menu View->Testing

A continuacién, se debera seleccionar del explorador aquel elemento al que se vayan a vincular las

pruebas, y se visualizara la siguiente pantalla:
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Para la creacion de las Pruebas Unitarias, se seleccionara la pestafia de Unit, y pulsando el botén New,
se podran definir las distintas pruebas a realizar.

Para ello se informaran los siguientes campos:
e Test -> Nombre del test
e Description ->Descripcion funcional de la prueba.
[ ]
[ ]

Input ->Juego de datos de entrada
Results -> Resultados esperados

Informados dichos campos, para guardar los datos se pulsara el botén Save.

Para el resto de pruebas, la definicion de los Tests, se realizara sobre cada una de las carpetas creadas
al efecto.

Pruebas de Integracién

Los tests se crearan en la pestafia de Integration
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Los tests se crearan en la pestafia de System
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Los tests se crearan en la pestafia de Scenario

173/178




- Eusko Jaurlaritzaren Informatika Elkartea
l Sociedad Informatica del Gobierno Vasco

@ EJIE_E

File Edit Miew Project Diagram  Element Tools  Add-Ins  Settings  Window  Help

B RODSB9. BEC O %He ADR >

PLO -

: oAl » Auk~ [[]E ABE

T X Component Diagram: "Pruebas Unitarias”  created: 15/04/2008 19:03:47 modified: 15/04/2008 19:09:03 100% 827 %1 x Bro & g
1= — ” e |
M 8 A B-B-lcEdSan |
Analysis | || = @ Disefio it
e Modula Funcional
I =5 Requerimientos Del Sistemna
| Class [®] casos de Uso
; Compasite @ Arquitectura Sistema
= = T‘ ?‘ Diagrama de Clases
i i Tesentac on apa {a}=3 e Es
| Communication J| : P Disefia Fisica Dakas
| Interaction =] tvalidationesbensicds bt [@] Construccion Sistema
= 1 =1 + Campos Date [@] Migracion y Carga Inicial Datos
i_ _Tlmlng _i = + Campos Humerico EI Plan de Prusbas
| State LA [~ Entorno Prushas
Activity oE- [_1 Plan Pruehas
- - { | : -~ =8 Plan Pruebas
| Component | a| i - L:I Pruebas Unitarias
il 2| : o Z Pruebas Inte i
—_— — - £ i i gracion
! B Package | Stark Page L Plan Pr'uebas\ Pruebas Unitarias ] I : 21 Prusbas Sistema
| B class ! : = : <[] Pruebas Aceptacion
| #0  Interface > %} = @ [| - [=] Entidades Implicadas
™  Object Status ||| Test: | EP-PIM-O0L '
I:] Rt Skatus: Bt Type: v
| Deploymert : - | . Run By: w | Checked By: | Last Run: ||:|
| Cuskam Description iResuIts!
; Prafile | Comprobar el acceso a la aplicacidn y navegacidn por las pantallas
i Metamode| |
1 1l
| ®ML Schema |
WSDL
| Requirements | il
; Maintenance . H o4 » p o Unit A Integration A System A Acceptance b Scenario ! |
| User Interface Pan & Zoam l:QProperties Q@Tagged alues GNotes Testing | _EProject Browser [ @Resources

-

| E 0808680

5 7

Diefault Style - 7 'E: | &7 M ]

Pruebas Implantacion

174/178



- Eusko Jaurlaritzaren Informatika Elkartea
l Sociedad Informatica del Gobierno Vasco

@ EJIE_EJEMPLO - EA B@E|

File Edit Miew Project Diagram  Element Tools  Add-Ins  Settings  Window  Help

@"__"EDQ'EQ@ETSG’ S K DR oA

f BB B AT

R —4 |
Analysis | | = [ Disefio
lisetase, Modulo.FL.lncmnaI .
| =5 : Requerimientos Del Sistema
| Class v [@)] Casos de Uso
Composite Z @ Arquitectura Sistema
I i Diagrama de Clases
Communicakion Fresentacion Capa Datos . g~ F
I f + Dizefio Fisico Datos
Interaction IS ¥alidationss fpeticas bl - [@] Construccion Sistema
== [=L+:Gamps bate - [m] Migracion v Carga Inicial Datos
| Tirning 1l =l + Campos Humerico = EI Plan de Pruehas

]

| State | - ] Entorno Pruebas

Ackivity = ] Plan Pruehas
I - T : -~ =8 Plan Pruebas
| Component | - | | 2.4 i - ] Prusbas Unitarias
] Package . i i Cl Pruebas Il.ﬂtegracmn
| [ : Fe 1 Pruehas Sistema
B class — = : -] Pruebas Aceptacion
| #0  Interface [| - [=] Entidades Implicadas
™ Object || Test: [ Ep-Pacont '
I:] Rt Skatus: Bt Type: v
| Deployrent i v-l Fun By: w | Checked By: v
| Custam | | Description [1nput | Acceptance Criteria | Results |
| Erafile Comprobar que se liste las empresas correckamente v el acceso sea rapido,
Metamode|
|
| ®ML Schema
WSDL
| Requirements | 1
Maintenance M 4 » MW Unit A Integration System » Acceptance / Scenario
! |
| User Interface @Pan & Zoom l:QProperties C@Tagged alues G Motes | Testing

—

57 7| pefault Style WAL

=

Pruebas Aceptacion

Pruebas de Aceptacion

Los tests se crearan en la pestafia de Acceptance
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5.10.2. Generacion Documentacion

Los accesos directos que se han de ejecutar para la creaciéon de los documentos intermedios son las
siguientes

DSI_10_1_Entorno_Pruebas
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Generate RTF Documentation

Fioaot Fackage: | E ntorno Pruebas |

Dutput ta file: | C:AUMLND ocumentosh DS 04D ocsA\0D51_10_1_Entorno_Prusbas. itf | [ ]

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurmnent
Use Template: | DSI_10_1_Entoma_Prusbas e |
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
[ ] Usze Intemal Viewer lze Language Substitutions

Progress:

DSI_10_2 Plan_Pruebas
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Generate RTF Documentation

oot Package: 3r'| F'rI_JE:tl |

Dutput ta file: | C:AUMLND ocumentosh DS 0WDocsA\D51_10_2 Plan_Pruebasz.rtf | [ ]

[ Fenerate Options. .. ] [ Resource Qu:u:ument...]

RTF Docurment

Use Template: | DSI_10_2_Plan_Pruebas v |
[ Manage Templates. .. ] [ Edit Current... ] [ Generate ]
[ Help ] [ Wi, ] [ Close ]
Dptionz
[ ] Usze Intemal Viewer Ilze Language Substitutions

Progress:

ent suocessiuly created . [ ]
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